Value-Added Reseller (VAR) Language

(i) the software component known as **ACUMATE** developed and licensed by Lucent Technologies Inc. of Murray Hill, New Jersey, to Oracle and imbedded in the Oracle Retail Predictive Application Server - Enterprise Engine, Oracle Retail Category Management, Oracle Retail Merchandise Financial Planning, Oracle Retail Advanced Inventory Planning and Oracle Retail Demand Forecasting applications.

(ii) the **MicroStrategy** Components developed and licensed by MicroStrategy Services Corporation (MicroStrategy) of McLean, Virginia to Oracle and imbedded in the MicroStrategy for Oracle Retail Data Warehouse and MicroStrategy for Oracle Retail Planning & Optimization applications.

(iii) the **SeeBeyond** component developed and licensed by Sun Microsystems, Inc. (Sun) of Santa Clara, California, to Oracle and imbedded in the Oracle Retail Integration Bus application.

(iv) the **Wavelink** component developed and licensed by Wavelink Corporation (Wavelink) of Kirkland, Washington, to Oracle and imbedded in Oracle Retail Store Inventory Management.

(v) the software component known as **Crystal Enterprise Professional and/or Crystal Reports Professional** licensed by Business Objects Software Limited ("Business Objects") and imbedded in Oracle Retail Store Inventory Management.

(vi) the software component known as **Access Via™** licensed by Access Via of Seattle, Washington, and imbedded in Oracle Retail Signs and Oracle Retail Labels and Tags.

(vii) the software component known as **Adobe Flex™** licensed by Adobe Systems Incorporated of San Jose, California, and imbedded in Oracle Retail Promotion Planning & Optimization application.

(viii) the software component known as **Style Report™** developed and licensed by InetSoft Technology Corp. of Piscataway, New Jersey, to Oracle and imbedded in the Oracle Retail Value Chain Collaboration application.

(ix) the software component known as **i-net Crystal-Clear™** developed and licensed by I-NET Software Inc. of Berlin, Germany, to Oracle and imbedded in the Oracle Retail Central Office and Oracle Retail Back Office applications.

(x) the software component known as **WebLogic™** developed and licensed by BEA Systems, Inc. of San Jose, California, to Oracle and imbedded in the Oracle Retail Value Chain Collaboration application.

(xi) the software component known as **DataBeacon™** developed and licensed by Cognos Incorporated of Ottawa, Ontario, Canada, to Oracle and imbedded in the Oracle Retail Value Chain Collaboration application.
# Contents

## Preface

Audience .................................................................................................................................................................. ix
Related Documents ............................................................................................................................................... ix
Customer Support ........................................................................................................................................... x
Review Patch Documentation ....................................................................................................................... x
Oracle Retail Documentation on the Oracle Technology Network ................................................................. x
Conventions ....................................................................................................................................................... x

## 1 Managing Users

### Overview of User Management

- About User Account Roles ......................................................................................................................... 1-2
- About Hierarchy Levels ................................................................................................................................. 1-2
- About Assigning Roles and Hierarchies ................................................................................................. 1-2

### User Account Roles

- User Management Roles .............................................................................................................................. 1-3
- Plan Roles .................................................................................................................................................... 1-3
- Merchant Desktop Roles ............................................................................................................................... 1-4

### Managing User Accounts

- Starting User Management ......................................................................................................................... 1-5
- Changing the Password for the Default User Account ........................................................................... 1-6
- Creating a User Account ............................................................................................................................... 1-7
- Assigning Roles and Hierarchy Levels to a User Account ........................................................................ 1-8
- Modifying User-Related Information ........................................................................................................ 1-9
- Modifying Role and Hierarchy Assignments ............................................................................................. 1-10
- Removing User Accounts ............................................................................................................................ 1-11
- Locking and Unlocking User Accounts .................................................................................................... 1-11
- Expiring the User Accounts ....................................................................................................................... 1-12

### Working with the User Management User Interface

- Sorting Columns ............................................................................................................................................ 1-12
- Rearranging Columns ................................................................................................................................. 1-13
- Hiding Columns .......................................................................................................................................... 1-13
- Printing and Exporting User Account Information .................................................................................. 1-14

### Troubleshooting User Management Errors

- MicroStrategy Users Licenses Exceeded ................................................................................................. 1-15
- MicroStrategy Users Table General Failure ............................................................................................ 1-15
2 Managing Business Rules

About Business Rules .............................................................................................................. 2-1
Plan Business Rules .................................................................................................................. 2-2
Understanding the Business Rule Management User Interface .............................................. 2-4
   Business Rules Filters Panel .............................................................................................. 2-5
   Business Rules Grid Panel ............................................................................................... 2-5
Locating Your Business Rules ................................................................................................. 2-6
   Browsing Through the Hierarchies .................................................................................. 2-6
   Expanding the Hierarchies Within the Grid ...................................................................... 2-7
   Finding a Hierarchy Entity ................................................................................................. 2-8
Modifying the Business Rule Settings .................................................................................... 2-9
Copying the Business Rule Settings ....................................................................................... 2-10
Removing the Business Rule Settings .................................................................................... 2-10
Viewing the History of All the Business Rule Modifications ................................................... 2-11
   About the Business Rule History Screen ......................................................................... 2-11

3 Managing Stores

Understanding Store Sets and Subsets .................................................................................... 3-1
Accessing the Store Set Management Utility ........................................................................... 3-2
Managing Store Sets ................................................................................................................ 3-3
   Creating a New Store Set ................................................................................................. 3-3
   Copying the Selected Store Set ...................................................................................... 3-3
   Renaming the Selected Store Sets .................................................................................... 3-4
   Merging the Selected Store Sets ..................................................................................... 3-4
   Removing the Selected Store Sets ................................................................................... 3-5
   Viewing Other Store Sets ............................................................................................... 3-6
   Printing and Exporting the Store Set Information ............................................................ 3-7
   Sorting the User Account Information ............................................................................. 3-7
   Customizing the Columns ............................................................................................... 3-8
Managing Subsets .................................................................................................................... 3-9
   Subsets Tab ..................................................................................................................... 3-9
      Subsets Tab Screen ...................................................................................................... 3-9
      Subsets Tab Components ........................................................................................... 3-10
      Creating a New Subset ................................................................................................. 3-11
      Renaming the Selected Subsets .................................................................................... 3-11
      Combining the Selected Subsets ................................................................................... 3-11
      Removing the Selected Subsets .................................................................................... 3-12
      Changing the Store Set Type to Static ....................................................................... 3-13
      Adding Specific Stores to the Subset ........................................................................... 3-13
      Customizing the Table ............................................................................................... 3-13
      Printing or Exporting Information .............................................................................. 3-13
   Filters Tab ........................................................................................................................ 3-14
      Filters Tab Screen ....................................................................................................... 3-14
4 Managing Reports

About Merchant Desktop ................................................................. 4-1
  Administrative Roles .................................................................. 4-1
  Accessing Merchant Desktop .................................................. 4-2

Post-Installation Configuration ............................................. 4-2

Administrative Tasks ................................................................. 4-5
  About Views, Screens, and Components .................................. 4-5
  Updating the Unassigned View Message ............................... 4-6
  Getting Started with Views and Their Elements .................. 4-7
    Modifying and Deploying Sample Views and Their Elements 4-7
    Creating and Deploying Views and Their Elements .......... 4-8
  Understanding Updates ......................................................... 4-8
    Forcing Updates .............................................................. 4-9

View Administration ................................................................. 4-9
  View Administration Screen Fields .................................... 4-9
    Creating a View ............................................................ 4-10
    Copying a View .......................................................... 4-11
    Editing a View ............................................................ 4-11
    Deleting a View ........................................................... 4-11
    Assigning a View to a User ............................................. 4-12
    Adding Screens to a View .............................................. 4-12

Screen Administration .............................................................. 4-13
  Screen Administration Screen Fields ................................. 4-13
    Creating a Screen ........................................................ 4-14
    Copying a Screen ........................................................ 4-18
    Editing a Screen ......................................................... 4-18
    Deleting a Screen ........................................................ 4-18
    Adding Components to a Screen .................................... 4-18

Component Administration ..................................................... 4-19
  Component Administration Screen Fields ......................... 4-19
    Creating a Component ................................................. 4-20
    Copying a Component ................................................ 4-22
    Editing a Component .................................................. 4-22
    Deleting a Component ................................................ 4-22
    Component Types ........................................................ 4-22

Working with the Reports ....................................................... 4-28
Generating the Reports......................................................................................................... 4-28
Creating Your Own Reports .................................................................................................. 4-29
   Using the Report Builder ................................................................................................. 4-29
   Using the Report Wizard ............................................................................................... 4-29
Setting Up Preferences ........................................................................................................ 4-29
   Preference Categories ..................................................................................................... 4-29
Viewing the Reports ............................................................................................................. 4-33
   Report Menu ....................................................................................................................... 4-34
   View Menu ......................................................................................................................... 4-34
   Data Menu ......................................................................................................................... 4-36
   Format Menu ...................................................................................................................... 4-37
**Personalizing Merchant Desktop**.................................................................................. 4-38
   About Personalization ........................................................................................................ 4-38
   Personalization Privileges ............................................................................................... 4-38
   Personalizing Your View ................................................................................................... 4-39
   Personalizing Screens ....................................................................................................... 4-40
   Personalizing Components ............................................................................................. 4-42
   About Views ...................................................................................................................... 4-42
   About Screens ................................................................................................................... 4-42
   About Components ......................................................................................................... 4-43
      Component Types ......................................................................................................... 4-43
**Troubleshooting**............................................................................................................ 4-46
**Good Practices**............................................................................................................... 4-49
   Copy the Sample Views, Screens, or Components ......................................................... 4-49
   Lock Views, Screens, or Components until You Are Ready to Share Them .................. 4-49
   Test Your Views, Screens, or Components with Test User Accounts ......................... 4-49

5 **Managing Subscriptions to DAL Capture**
   About the DAL Capture Mechanism ................................................................................ 5-1
   Subscribing User Accounts for DAL Capture ................................................................. 5-1

Index
Preface

This guide enables you to perform the following administration tasks:

■ Managing user accounts
■ Managing business rules
■ Managing store sets
■ Managing reports
■ Managing subscriptions to DAL Capture

Audience

This guide is intended for Plan administrators and assumes that you are familiar with the following:

■ Security (access control, permissions, and authorization)
■ Retail domain metrics and terminology
■ Any company-specific policies, such as your naming conventions for merchandise and location hierarchies, naming conventions, and business practices

Note: This guide describes the default implementation and default on screen labels. Your company may have customized the labels. In those situations, the screen labels on your user interface may not match the screen labels described in this guide.

Related Documents

For more information, the following documents are available in the Oracle Retail Plan Release 12.1 documentation set:

■ Oracle Retail Plan Installation Guide
■ Oracle Retail Plan Configuration Guide
■ Oracle Retail Plan Operations Guide
■ Oracle Retail Plan User Guide
Customer Support

- https://metalink.oracle.com

When contacting Customer Support, please provide:

- Product version and program/module name
- Functional and technical description of the problem (include business impact)
- Detailed step-by-step instructions to recreate
- Exact error message received
- Screen shots of each step you take

Review Patch Documentation

For a base release (".0" release, such as 12.0), Oracle Retail strongly recommends that you read all patch documentation before you begin installation procedures. Patch documentation can contain critical information related to the base release, based on new information and code changes that have been made since the base release.

Oracle Retail Documentation on the Oracle Technology Network

In addition to being packaged with each product release (on the base or patch level), all Oracle Retail documentation is available on the following Web site:

http://www.oracle.com/technology/documentation/oracle_retail.html

Documentation should be available on this Web site within a month after a product release. Note that documentation is always available with the packaged code on the release date.

Conventions

The following text conventions are used in this document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td><code>monospace</code></td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>
Each person using the Oracle Retail application needs a user account with specific permissions, which determine what specific tasks that person can perform. This chapter includes the following sections:

- "Overview of User Management" on page 1-2
- "User Account Roles" on page 1-3
- "Managing User Accounts" on page 1-5
- "Working with the User Management User Interface" on page 1-12
- "Troubleshooting User Management Errors" on page 1-15

**Important:** If you are using Merchant Desktop and MicroStrategy, ensure that MicroStrategy has been installed and the RMIServer service is running before creating user accounts. For information about installing MicroStrategy, see the application *Installation Guide*. For information about Merchant Desktop and MicroStrategy user account integration, see "Merchant Desktop Roles" on page 1-4.
Overview of User Management

The User Management utility enables you to create, modify, and inactivate user accounts. User accounts enable you to provide user-specific access control permissions.

There are two ways to manage user accounts:

- If you need to manage multiple user accounts all at once, use the Bulk Loader as described in the application Configuration Guide. This guide assumes that most of your user accounts have already been created, by means of the Bulk Loader.
- If you need to add or modify one or two user accounts, use the User Management user interface as described in this chapter.

User account permissions consists of a combination of specific roles (the scope of actions a user can perform) and hierarchy levels (the scope of business data a user can access). You can assign as many roles and hierarchy levels to a user account as necessary.

About User Account Roles

A role specifies the scope of actions a user is allowed to perform. Each application comes with a set of default user account roles. If you need to add user account roles or modify the actions available for user account roles, use the Bulk Loader XML files as described in the application Configuration Guide.

About Hierarchy Levels

A hierarchy level defines the scope of business data a user has permissions to access. Hierarchy level consists of the combination of the following:

- Location Hierarchy
- Merchandise Hierarchy

About Assigning Roles and Hierarchies

Important: Setting the location hierarchy level below the chain level is not supported in Plan and may result in unpredictable behavior.

If you assign the top level of both the merchandise and location hierarchies to a role, the user has access to all hierarchy levels for that role.

If you want the user to have access to a specific merchandise-location hierarchy combination, you do so by specifying the roles and their associated hierarchies. For example, to assign permissions to submit for only Departments 314 and 327 for all locations, you would add two 'submit' roles to the user account and assign a specific merchandise hierarchy to each role, as shown below:

**PLAN_SUBMITTER** – Merchandise Department 314 and Location Chain
**PLAN_SUBMITTER** – Merchandise Department 327 and Location Chain
User Account Roles

Along with the application user account roles, the Oracle Retail applications ship with the following types of user account roles:

- "User Management Roles" on page 1-3
- "Plan Roles" on page 1-3
- "Merchant Desktop Roles" on page 1-4

User Management Roles

User Management roles enable you to add, modify, and remove user accounts. Review the list below to determine which User Management roles to assign a user. For example, you may want to assign one user the ability to create user accounts but assign a different user the ability to assign roles to those accounts.

When a user who has been assigned User Management roles logs on, the User Management link on the main menu opens to the User Management utility.

When a user who has not been assigned User Management privileges logs on, the User Management link opens to a password management dialog box.

The application comes with the following User Management roles:

- **UM_USER_ADMIN** – This role allows creating new user accounts. It does not allow assigning roles.
- **UM_ROLE_ASSIGNER** – This role allows assigning roles to the existing user accounts. It does not allow creating or deleting user accounts. A person who uses this role must understand the available merchandise and location hierarchies as described in "About Hierarchy Levels" on page 1-2.
- **UM_READ_ONLY_ADMIN** – This role has privileges to view the list of users and their access permissions. This role does not allow adding, modifying, or deleting user accounts.

Plan Roles

The Plan application comes with the following default roles:

- **PLAN_VIEWER**
- **PLANNER**
- **PLAN_SYSADMIN**
- **PLAN_BIZADMIN**

The following table describes the actions assigned to the initial set of roles:

<table>
<thead>
<tr>
<th>Roles</th>
<th>View Plans</th>
<th>Perform What-If</th>
<th>Edit/Create Plans</th>
<th>Submit and Publish Plans</th>
<th>Edit Business Rule Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLAN_VIEWER</td>
<td>Yes</td>
<td>Yes*</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>PLANNER</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>PLAN_SYSADMIN</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>–</td>
</tr>
<tr>
<td>PLAN_BIZADMIN</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
* Users with PLAN_VIEWER roles can perform What-If calculations, but cannot save the results.

**Merchant Desktop Roles**

The hierarchy levels you assign to Merchant Desktop roles determine which hierarchy levels appear in enhanced reports.

Having the enhanced reporting access set by a Merchant Desktop role allows you to provide a more varied hierarchy coverage. For example, if people in many departments need access to enhanced reporting, you may want to give them more extensive access so that they can view data from other departments as well.

The application comes with the following Merchant Desktop roles:

- **MD_USER** – Supplied by default. This role has read-only access to the view and all of the screens and components it contains. It also includes access to MicroStrategy reports.
  
  Assign this role when you want to ensure that a user cannot make any changes and that they always receive updates from you. The merchandise-location hierarchy combinations you assign to this role determine what data appears in reports.

  As with the Oracle Retail applications roles, if you want a user to have access to multiple hierarchy combinations, you must add one role for each combination. For example:

  MD_USER – Merchandise Department 314 and Location Chain
  MD_USER – Merchandise Department 327 and Location Chain

  Assign this role when you want to ensure that a user cannot make any changes and that they always receive updates from you.

- **MD_POWER_USER** – Supplied by default. This role has rights to personalize views, to create and remove screens and components, and to set individual parameters as allowed by the Merchant Desktop administrator. This role has access to MicroStrategy. Power users can copy and modify reports, but they cannot create reports.
  
  Assign the power user role when you want to allow a user to make changes to their Merchant Desktop views. However, be aware that to ensure that their changes are preserved, you cannot automatically update some elements of their view or screens.

- **MD_ADMINISTRATOR** – Supplied by default. This role has all rights to create, modify, and remove views, screens, components, and reports. This role has rights to set permissions for several parameters for power users.

  The administrator role includes Web Professional privileges in Microstrategy - giving Administrators the ability to create reports using the Design Mode option in Microstrategy. Design mode provides a more flexible and intuitive interface for creating and modifying reports than the Report Builder/Wizard functionality. Only administrators can create reports.

- **MD_REPORT_ADMIN** – Supplied by Oracle Professional Services. This role has the same permissions as the MD_POWER_USER role plus MicroStrategy Web Professional permissions. This additional level of permissions allows Report Administrators to create reports using the Design Mode option in Microstrategy. Design mode provides a more flexible and intuitive interface for creating and modifying reports than the Report Builder/Wizard functionality.
Merchant Desktop and MicroStrategy User Integration

Because of the relationship between Plan User Management and the MicroStrategy, be aware of the following:

- As long as the RMIServer service is running while you are creating user accounts, any Plan user account that you create that includes a Merchant Desktop role is automatically imported into the MicroStrategy users database.

  *As a result, use Plan User Management—not MicroStrategy—when managing user accounts.*

- Any changes you make to the MicroStrategy users database are not imported back to the User Management user database.

  *As a result, use User Management—not MicroStrategy—when managing user accounts.*

- The user names that you create in Plan are case-sensitive, but the MicroStrategy user names are not.

  For example, the application treats "Admin" and "admin" as two unique user accounts. However, MicroStrategy treats them as the same user name and expects the same password for both of these user accounts.

  If you add an account that has the same syntax but different case, the MicroStrategy password for that duplicate name is changed to match that of the new user.

  *As a result, avoid using upper-case and lower-case to differentiate between user names.*

Managing User Accounts

The User Management user interface enables you to add, modify, or remove user accounts. It also enables you to assign or modify the hierarchy levels assigned to a user account.

This section describes how you can effectively use the User Management user interface to manage the user accounts. It includes the following tasks:

- "Starting User Management" on page 1-6
- "Changing the Password for the Default User Account" on page 1-6
- "Creating a User Account" on page 1-7
- "Assigning Roles and Hierarchy Levels to a User Account" on page 1-8
- "Modifying User-Related Information" on page 1-9
- "Modifying Role and Hierarchy Assignments" on page 1-10
- "Removing User Accounts" on page 1-11
- "Locking and Unlocking User Accounts" on page 1-11
- "Expanding the User Accounts" on page 1-12
Starting User Management

The User Management utility is available after you have installed the application, and it is accessible via the application main menu.

To access the User Management utility for the first time, use the default user name and the associated password to log on to the application. This user account is a special account that provides access to all the User Management functions, and provided to you during the implementation.

After you log on for the first time, you can create accounts for the additional users who need access to the User Management utility. In addition, you might want to change the root user account password. For more information, see “Changing the Password for the Default User Account” on page 1-6.

To manage user accounts:

1. Open a browser and enter the application URL, similar to the following:

   For Plan, https://servername:portnumber/plan/PlanLogin.do

   The login screen appears.

2. Enter the root user name and password, and click Login.

   The main menu appears with the User Management link.

3. Click the User Management link.

   The Manage Users screen appears with a list of user accounts. For information about creating user accounts, see “Creating a User Account” on page 1-7.

   To quit User Management, click the Close link. The main menu appears.

Changing the Password for the Default User Account

When you first access the User Management utility, you must use the default user account already set up for you. For security reasons, you must change the password associated to this account.

To change the password for the root account:

1. On the Manage Users screen, select Change Password from the Action list, and then click Apply.

   The Set Root Password for user: root dialog box appears.

2. In the Old Password text box, enter the existing password, and in the New Password and Confirm New Password text boxes, enter the new password you want.

   Reminder: Passwords are case-sensitive.

3. When the dialog box is complete, click Done.

   You must use the new password the next time you attempt to log on using the root account.
Creating a User Account

You must create a user account for each user who needs access to the application. For each user account, you must then assign one or more roles that determine what products and features a user can access.

There are two ways to create user accounts:

- If you need to create multiple user accounts all at once, use the User Management Bulk Loader utility. For more information, see the section Understanding the User Management Bulk Loader Utility in the Configuration Guide.
- If you need to add or modify one or two user accounts, use the User Management user interface as described in this section.

To create a user account:

1. On the Manage Users screen, select Add New User from the Action list, and then click Apply.
   The Add New User dialog box appears.
2. Complete the Add New User dialog box fields, as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>Required. The user name must be unique for each user. The user name is case-sensitive and can be up to 50 characters (letters, numbers, and symbols) long. For example, Buyer, buyer, and BUYER are all considered to be unique. In general, avoid using upper and lower case to differentiate between accounts. This is especially important if you are using Merchant Desktop and MicroStrategy. For more information, see “Merchant Desktop Roles” on page 1-4.</td>
</tr>
<tr>
<td>Password</td>
<td>Required. The password is associated with the user name, and both are required to log on. The password is case-sensitive and can be up to 50 characters (letters, numbers, and symbols) long. For example, Secret, secret, and SECRET are all considered to be unique.</td>
</tr>
<tr>
<td>First Name</td>
<td>Optional, up to 50 characters. Helps you to identify the person assigned to a user name. For example, if your user names are generic labels (such as WomensBuyer001 and MensBuyer300), this information enables you to identify which employee is assigned to a specific user name.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Optional, up to 50 characters. Helps you to identify the person assigned to a user name.</td>
</tr>
<tr>
<td>MI</td>
<td>Optional, 1 character. Helps you to identify the person assigned to a user name.</td>
</tr>
<tr>
<td>Employee ID</td>
<td>Optional, up to 10 numbers. The employee ID is available for your internal use.</td>
</tr>
<tr>
<td>Title</td>
<td>Optional, up to 50 characters. Helps you to identify the person assigned to a user name.</td>
</tr>
<tr>
<td>Email</td>
<td>Optional. The e-mail address associated with the user account. In the Promotion Intelligence and Promotion Planning and Optimization application, using this e-mail address, notifications can be sent to the users informing them about the workflow tasks that require their attention.</td>
</tr>
</tbody>
</table>
3. When the fields are complete, click **Done**.

   The Manage Users screen appears with the user name and related identifiers added.

   Now that you have created the user account, the next step is to assign the appropriate permissions as described in "Assigning Roles and Hierarchy Levels to a User Account" on page 1-8.

### Assigning Roles and Hierarchy Levels to a User Account

Each user account must have one or more role associated with the applicable hierarchies. For information about roles and hierarchies, see "Overview of User Management" on page 1-2.

Important: If you are using Merchant Desktop, see "Merchant Desktop Roles" on page 1-4.

---

**Note:** You can only add user roles one at a time from the graphical user interface. For instructions on how to add multiple roles all at once, see information about the Bulk Loader as described in the *Configuration Guide*.

---

To assign roles to a user account:

1. From the **Manage Users** screen, select the user account to which you want to assign roles.

2. From the **Action** list, select **User Roles**, and then click **Apply**.

   The **Role Assignment for username** screen appears.

3. From the **Action** list, select **Add Role Assignment**, and then click **Apply**.

   The **Add Role Assignment** dialog box appears.

4. From the **Role** list box, select the role you want to assign to this user account. For details on the default roles supplied with Plan, see "User Account Roles" on page 1-3. Note that your implementation may have additional customized roles as well.

5. For any business-related role (any role except for User Management roles) specify the hierarchy levels you want this user to be able to access.

   To navigate down the hierarchy, hover your mouse pointer over the right arrow in the hierarchy. Keep navigating until the target level appears, and then click it.

*Figure 1–1 Assigning Hierarchy Levels to the Role*

<table>
<thead>
<tr>
<th>Role</th>
<th>Hierarchy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Rule Manager</td>
<td>The hierarchy levels determine the items and pricing groups for which a user can view/update business rules.</td>
</tr>
</tbody>
</table>

- To navigate down a hierarchy, use the right arrow.
- To navigate up a hierarchy, use the left arrow.
Managing User Accounts

Managing Users

6. After you have selected the role and any applicable hierarchy levels, click Done.

The Role Assignment for <username> screen updates with the role and hierarchy levels added.

If an error message appears instead, see "Troubleshooting User Management Errors" on page 1-15.

7. Repeat steps 3 through 6 to add as many roles as necessary. When you are finished adding roles, click Done to return to the Manage Users screen.

---

Modifying User-Related Information

Modifying user-related information involves changing the user name, password, first name, and last name. Typically, you would modify a user account in a situation where the required activities remain the same, but the employee has been reassigned to other tasks.

If you want to change the permissions associated with a user account, see "Modifying Role and Hierarchy Assignments" on page 1-10.

---

<table>
<thead>
<tr>
<th>Role</th>
<th>Hierarchy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan</td>
<td>The entire location hierarchy is within the scope of every action.</td>
</tr>
<tr>
<td>Merchant Desktop</td>
<td>The hierarchy levels determine which alerts can appear to a user and which data a user can view in reports.</td>
</tr>
</tbody>
</table>

---

Note: If you assign different roles within the same hierarchy levels, the role with the most privileges takes precedence. For example, if you assign a read-only role and a power user role for the same hierarchy, the power user role for that hierarchy is used when the user logs on.

---

To modify a user account:

1. On the Manage Users screen, select the user account you want.

2. From the Action list, select Edit Existing User, and click Apply.

The Edit User screen appears.

3. Change the field values as necessary.

4. Click Done.

The Manage Users screen appears with the updated information. Changes to the user account are effective the next time the user attempts to log on.
Modifying Role and Hierarchy Assignments

For each user account, you can do the following:

- Add or remove roles
- Change the hierarchy levels associated with a specific role

---

**Note:** You can only modify roles and roles assignments one at a time from the graphical user interface. For instructions on how to add multiple roles all at once, see information about the Bulk Loader as described in the Configuration Guide.

---

To modify a role:

1. From the **Manage Users** screen, select the user account whose roles or hierarchy levels you want to modify.
2. From the **Action** list, select **User Roles**, and click **Apply**.

   The **Role Assignment for <username>** screen appears.
3. From the **Action** list, select **User Roles**, and click **Apply**.

   Do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign a role</td>
<td>1. From the <strong>Action</strong> list, select <strong>Add Role Assignment</strong>, and then click <strong>Apply</strong>. For a list of available roles, see &quot;User Account Roles&quot; on page 1-3.</td>
</tr>
<tr>
<td></td>
<td>2. On the <strong>Add Role Assignment</strong> dialog box, select a role and its associated hierarchy levels, and click <strong>Done</strong>.</td>
</tr>
<tr>
<td>Change the hierarchy levels</td>
<td>1. Select the roles for which you want to change the hierarchy levels. For information about hierarchy levels, see &quot;About Hierarchy Levels&quot; on page 1-2.</td>
</tr>
<tr>
<td></td>
<td>2. From the <strong>Action</strong> list, select <strong>Edit Role Assignment</strong>, and then click <strong>Apply</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. On the <strong>Edit Role Assignment</strong> dialog box, select the new hierarchy levels. (Alternatively, you could select a new role and keep the hierarchy levels.)</td>
</tr>
<tr>
<td>Remove a role</td>
<td>1. Select the roles you want to remove.</td>
</tr>
<tr>
<td></td>
<td>2. From the <strong>Action</strong> list, select <strong>Delete Role Assignment</strong>, and then click <strong>Apply</strong>. The role is removed immediately.</td>
</tr>
</tbody>
</table>

*Caution:* There is no undo, and there is no confirmation dialog box.

4. When the screen reflects the changes, click **Done**.

   The change take effect the next time the user logs on.
Removing User Accounts

Removing an user account enables you to remove the user from the list. You may want to remove an user account when the assigned user moves to a different position or no longer needs access. The removed users can not be re-activated.

When you remove a user account, that account is preserved in the database for reports and historical data. Use caution when removing a user account.

---

**Important:** Removing a user account is **permanent**. There is no undo function. If you decide later that you need this account, you must create a new one.

If you simply want to remove access to a product or to an area of the hierarchies for a specific user account, see "Modifying Role and Hierarchy Assignments" on page 1-10. If you want to reassign a user account to another person, see "Modifying User-Related Information" on page 1-9.

---

To remove a user account:

1. On the Manage Users screen, select the user accounts you want to remove.
2. From the Action list, select Remove User, and then click Apply.
   
   A confirmation dialog box appears.
3. Click Yes to remove the user account.
   
   The user account is removed from the list. If anyone attempts to use this account, the login will fail.

Locking and Unlocking User Accounts

Use the Lock and Unlock Accounts features to control user access to the application. Locking an user account restricts access to the software temporarily, and the account can be unlocked with all the access privileges assigned to the user restored.

To lock a user account:

1. On the Main Menu, click the User Management link.
2. On the Manage User screen, click the check box next to the user account you want.
3. From the Action list, select Lock Account, and then click Apply.
   
   A confirmation dialog box appears.
4. Click Yes.

To unlock a user account:

1. On the Main Menu, click the User Management link.
2. On the Manage User screen, click the check box next to a locked user account you want.
3. From the Action list, select Unlock Account, and then click Apply.
   
   A confirmation dialog box appears.
4. Click Yes.
Expiring the User Accounts

Use the *Expire User Account* feature to force the user to reset the password associated with the user account. The user must now set up a new password, before logging on to the application.

The expired user account can be re-activated by the user by resetting the password associated with the user account.

To expire the user account:

1. On the *Manage User* screen, click the check box next to the user account you want.
2. From the *Action* list, select *Expire User Account*, and then click *Apply*. A confirmation dialog box appears.
3. Click *OK* to expire the password for the user account.

Working with the User Management User Interface

The User Management user interface enables you work with the user accounts you have created as follows:

- "Sorting Columns" on page 1-12
- "Rearranging Columns" on page 1-13
- "Hiding Columns" on page 1-13
- "Printing and Exporting User Account Information" on page 1-14

Sorting Columns

You can sort the data displayed on the following User Management screens:

- *Manage Users*
- *Role Assignments for username*

To sort the user and user roles data displays:

1. From the *Action* list, select *Sort Table*, and then click *Apply*. The *Customize Table* dialog box appears.
2. On the *Sort Table* tab, enter a sort criteria in the following manner:
   a. Select a column from the first list box.
      This column becomes the primary sort column for the data display.
   b. For that column, select a sort order, either ascending order (A - Z or 1 - 10) or descending order (Z - A or 10 - 1).
   c. If you want to sort the data by additional columns, select a column and sort order for the remaining two list boxes.
3. When the list boxes and sort order reflect the way you want the data to be sorted, click **Done**.

The Customize Table dialog box closes, and the data display is updated to the sort order you selected. The sort order remains in effect until you next change it.

### Rearranging Columns

You can rearrange the columns on the following User Management screens:
- Manage Users
- Role Assignments for username

To rearrange the columns:
1. From the **Action** list, click **Modify Columns**, and then click **Apply**.

   The Customize Table dialog box appears.
2. On the **Change Columns** tab, in the **Visible Columns** list box, select the column whose position you want to change.
3. Click the up or down arrow until the column is in its target location.
4. Repeat steps 2 and 3 as many times as necessary.
5. When the Customize Table dialog box reflects your settings, click **Done**.

   The Customize Table dialog box closes, and the screen updates with your modifications.

### Hiding Columns

You can hide columns on the following User Management screens:
- Manage Users
- Role Assignments for username

To hide (or show) columns:
1. From the **Action** list, click **Modify Columns**, and then click **Apply**.

   The Customize Table dialog box appears.
2. On the **Change Columns** tab, do one of the following:
   - To hide a column:
     - In the **Visible Columns** list box, select the column you want to hide.
     - Click the left arrow to move the column to the **Hidden Columns** list box.
   - To show a column:
     - In the **Hidden Columns** list box, select the column whose position you want to change.
     - Click the right arrow to move the column to the **Visible Columns** list box.
3. Repeat step 2 as many times as necessary.

**Note:** To remove one or more sort criteria, click **Select** from the list boxes.
4. When the **Customize Table** dialog box reflects your settings, click **Done**.

   The Customize Table dialog box closes, and the screen updates with your modifications.

### Printing and Exporting User Account Information

When you print or export information:

- **Only visible** columns are printed or exported.
  
  For example, if you chose to hide some columns (see "Hiding Columns" on page 1-13), the data in those columns is not included in the print out or the Microsoft Excel file. (Likewise, data that is filtered out or hidden in a collapsed row is exported or printed.)

- Information is printed or exported in the current sort order. (To change the sort order, see "Sorting Columns" on page 1-12).

To print or export user account information:

1. From the **Action** list on the screen you want, select **Print or Export**, and then click **Apply**.

   The Print or Export dialog box appears with a reminder that only the visible data will be printed or exported. The dialog box also indicate the number of rows and the columns, which helps you to estimate how long the print or export process will take.

2. Do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print the user data on the screen (not the screen itself)</td>
<td>Click <strong>Print</strong> and complete the resulting print dialog box as you normally would.</td>
</tr>
</tbody>
</table>
| Export the data to a Microsoft Excel spreadsheet | 1. Click **Send to Excel**.  
2. On the resulting Save As dialog box, enter a file name and click **Save**. An **Export Complete** message appears along with the path and file name of the Excel file, and the Excel file opens. |
Troubleshooting User Management Errors

This section enables you to troubleshoot the following user account management errors:

- "MicroStrategy Users Licenses Exceeded" on page 1-15
- "MicroStrategy Users Table General Failure" on page 1-15
- "MicroStrategy Failure Connecting to the Remote Registry" on page 1-16
- "Unable To Perform Request: System Error" on page 1-16
- "User Cannot Log In" on page 1-16

MicroStrategy Users Licenses Exceeded

When you attempt to add a Merchant Desktop role to a user account, the following message appears:

Unable to update the MicroStrategy Users table: licenses exceeded.

This error can occur when you have not updated the usermanagement.properties file for the number of MicroStrategy licenses you are using.

Solution

Correct this problem as follows:

1. Open the `<INSTALL_BASE>/config/usermanagement/usermanagement.properties` file.
2. Change the `microstrategy.users.max` value to the number of user licenses you have purchased.
3. Save the file and restart your application server.

MicroStrategy Users Table General Failure

When you attempt to add a Merchant Desktop role to a user account, the following message appears:

Unable to update the MicroStrategy Users table: General failure.

This error can occur for several reasons, mainly in the following categories. It occurs when you the string is built and posted to the MicroStrategy server. Check the following:

- `###MerchantDesktop Report Server rmiHost=ReportingServerName`  
  `rmiPort=44499` # In most cases, rmiHost and reportServer should be the same  
  `reportServer=ReportingServerName`  
  `administratorName=administrator`  
  `administratorPassword=mdProject=Merchant Desktop`

- There is a mismatch between the hierarchy level names that User Management is using and those that are defined in Merchant Desktop.
- The MicroStrategy server is down.
MicroStrategy Failure Connecting to the Remote Registry

When you attempt to add a Merchant Desktop role to a user account, the following message appears:

MicroStrategy Integration: General failure connecting to the remote registry.

Solution
This error can occur when the RMIServer service is not running.

- Make sure you have installed the MicroStrategy User Management Integration Server as described in the *Plan Configuration Guide*.
- Once the MicroStrategy User Management Integration Server is installed, verify that the RMIServer service is running. (On the MicroStrategy server, select Start > Settings > Control Panel > Administrative Tools > Services.)

Unable To Perform Request: System Error

The following error message can occur in a variety of circumstances:

Unable to perform request due to system error

Solution
Perform the following:

- Verify that the network is not having problems.
- Verify that the User Management database is available.

User Cannot Log In

A user reports that their username and password combination is no longer working.

Solution
Log in problems are usually due to case-sensitivity issues. To solve this problem, perform the following:

- Make sure that the user has not selected the Caps Lock key.
- If you have recently changed their Plan password or username, it is possible that Internet Explorer is storing the former password. This can occur when the only change in the user name or password is case.
- If you added a Merchant Desktop account whose user name differs only in case to an existing user name, the MicroStrategy password for that "duplicate" name is changed to match that of the new user. See "Merchant Desktop and MicroStrategy User Integration" on page 1-5.
Managing Business Rules

Business rules specify the constraints that an application uses when performing calculations, forecasts, and other automated processing.

This chapter contains the following sections:
- "About Business Rules" on page 2-1
- "Plan Business Rules" on page 2-2
- "Understanding the Business Rule Management User Interface" on page 2-4
- "Locating Your Business Rules" on page 2-6
- "Modifying the Business Rule Settings" on page 2-9
- "Copying the Business Rule Settings" on page 2-10
- "Removing the Business Rule Settings" on page 2-10
- "Viewing the History of All the Business Rule Modifications" on page 2-11

About Business Rules

Business rules are applied to items, not to the pricing groups. Instead, business rules apply for each item regardless of membership in a pricing group. When items in the same pricing group have differing out dates, target sell throughs, salvage values, and so on, the final value is derived by rules set during the implementation.

**Note:** Although business rules are applied to items instead of pricing groups, typically business rules are set at higher levels in the merchandise hierarchy than the item level.

Within the Plan application, the relevant business rules are similarly applied to actualized and mock items.
Plan Business Rules

The following table describes the business rules shipped along with the Plan application:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUR_ADJUSTMENT_PCT</td>
<td>The average unit retail discount percent. Used in the display of new plans. Default Label: Average Unit Retail Discount Percent Default Value: 12</td>
</tr>
<tr>
<td>ANNUAL_BASICS_PLAN_MIN</td>
<td>Optional. The minimum annual receipt quantity. Used to calculate the minimum value for new basic items and to validate basic items. Default Label: Annual Basics Plan Minimum Default Value: 12</td>
</tr>
<tr>
<td>SAFETY_STOCK</td>
<td>The additional time, in days, to stock an item so that it is not out-of-stock. Default Label: Safety Stock Default Value: 14</td>
</tr>
<tr>
<td>TOLERANCE_PCT</td>
<td>The acceptable variance, expressed as a percent, from the Store Financial Plan. Default Label: Tolerance Pct Default Value: 0.1</td>
</tr>
<tr>
<td>OOS_VALID_DAYS_OF_MONTH</td>
<td>Optional. List of days that are valid as out-of-stock days. Default Label: Out Of Stock Valid Days of Month Default Value: 1,15</td>
</tr>
<tr>
<td>PRODUCT_GROUP_ATTR</td>
<td>Indicates whether or not Product Groups are auto-generated or not. If auto-generated, also indicates which merchandise column is the source. Default Label: Product Group Attribute Default Value: None (not auto-generated)</td>
</tr>
<tr>
<td>STORE_QTY_LOW_THRESHOLD</td>
<td>Indicates the lower threshold for Store-level quantities that will be flagged as a potential concern. Expressed as a percentage. Any store that deviates from the average-per-store by this value will be flagged as Yellow in the Assortment View - Store Quantities screen. Default Label: Store Qty Low Threshold Attribute Default Value: 50</td>
</tr>
<tr>
<td>STORE_QTY_HIGH_THRESHOLD</td>
<td>Indicates the upper threshold for Store-level quantities that will be flagged as potential concern. Expressed as a percentage. Any store that deviates from the average-per-store by this value will be flagged as Red in the Assortment View - Store Quantities screen. Default Label: Store Qty High Threshold Attribute Default Value: 75</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PLAN_WINDOW_BEGIN_OFFSET</td>
<td>Indicates the number of weeks before the plan start date, when the application starts checking sales for the in-season items. This rule sets the starting week of a plan's adjusted window.</td>
</tr>
<tr>
<td></td>
<td>Default Label: In-season plan start offset</td>
</tr>
<tr>
<td></td>
<td>Default Value: 4</td>
</tr>
<tr>
<td>PLAN_WINDOW_END_OFFSET</td>
<td>Indicates the number of weeks after the plan end date, when the application stops checking sales for the in-season items. This rule sets the ending week of a plan's adjusted window.</td>
</tr>
<tr>
<td></td>
<td>Default Label: In-season plan end offset</td>
</tr>
<tr>
<td></td>
<td>Default Value: 4</td>
</tr>
<tr>
<td>ASV_LOW_THRESHOLD</td>
<td>Indicates the first threshold level (in percentage) at which a specific highlighting occurs (Yellow for Underperforming items and Pastel Green for Overperforming items) based on an item's performance. For more information on highlighting and item performance, see the Oracle Retail Plan User's Guide.</td>
</tr>
<tr>
<td></td>
<td>Default Label: Assortment View Low Threshold</td>
</tr>
<tr>
<td></td>
<td>Default Value: 20</td>
</tr>
<tr>
<td>ASV_HIGH_THRESHOLD</td>
<td>Indicates the second threshold level (in percentage) at which a specific highlighting occurs (Red for Underperforming items and Light Green for Overperforming items) based on an item's performance. For more information on highlighting and item performance, see the Oracle Retail Plan User's Guide.</td>
</tr>
<tr>
<td></td>
<td>Default Label: Assortment View High Threshold</td>
</tr>
<tr>
<td></td>
<td>Default Value: 50</td>
</tr>
</tbody>
</table>
Understanding the Business Rule Management User Interface

This section provides an overview of the Business Rule Management user interface.

To access the Business Rule Management utility:

- From the main menu, click **Business Rule Management**.

  The Business Rules screen appears.

*Figure 2–1  Business Rules Screen*

The Business Rules Manager screen has the following panels:

- Filters Panel – enables you to quickly navigate to any hierarchy level. See "Business Rules Filters Panel" on page 2-5.

Business Rules Filters Panel

The Filters panel enables you to quickly navigate to any hierarchy. The Filters panel is collapsible; once you find the hierarchy you want, you can close the Filters panel to make more room for the display of your business rules.

To close the Filters panel, click the double left-arrow (<<) button. To later display the Filters panel, click the double right-arrow (>>) button.

The following table describes the fields that appear in the Filters panel:

<table>
<thead>
<tr>
<th>Table 2–2 Business Rules Filters Panel Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td><strong>Merchandise and Location Sections</strong></td>
</tr>
<tr>
<td>Browse</td>
</tr>
<tr>
<td>Find</td>
</tr>
<tr>
<td>Attributes Section</td>
</tr>
<tr>
<td>■ To filter using no attributes, select the blank line.</td>
</tr>
<tr>
<td>■ To filter using all the attributes, select Any.</td>
</tr>
<tr>
<td><strong>Show Rules Section</strong></td>
</tr>
<tr>
<td>Higher levels with rules</td>
</tr>
<tr>
<td>Only filtered level</td>
</tr>
<tr>
<td>Set the table levels in the View option</td>
</tr>
</tbody>
</table>

Business Rules Grid Panel

The Business Rules Grid panel displays the business rules based on the filters that you have set up in the Filters panel. The panel displays a grid that provides information from the top level of both the Merchandise and Location hierarchy, including all the attributes. The following table describes the border and shading features used in the grid:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Border</td>
<td>Black border</td>
<td>You can edit the value.</td>
</tr>
<tr>
<td></td>
<td>Gray border</td>
<td>You cannot edit the value.</td>
</tr>
<tr>
<td>Cell color</td>
<td>Green cell</td>
<td>The rule value has been edited.</td>
</tr>
<tr>
<td></td>
<td>Normal cell</td>
<td>The rule value has not been edited.</td>
</tr>
<tr>
<td>Text color</td>
<td>Black text</td>
<td>The rule value has been set at this level.</td>
</tr>
<tr>
<td></td>
<td>Gray text</td>
<td>The rule value has been inherited.</td>
</tr>
</tbody>
</table>
Locating Your Business Rules

Business rules may be set on one or more levels in the hierarchies. There are several ways to locate your business rules:

- "Browsing Through the Hierarchies" on page 2-6
- "Expanding the Hierarchies Within the Grid" on page 2-7
- "Finding a Hierarchy Entity" on page 2-8

Browsing Through the Hierarchies

The Business Rule Management user interface enables you to select a node in the Merchandise and Location hierarchies by using expandable menus. This section helps you to use the expandable menus to effectively navigate through the hierarchies.

To navigate through the hierarchies:

1. On the Filters panel, under Merchandise or Location, click Browse.
2. Move the mouse pointer over the right arrow, next to Browse, to navigate through the hierarchy levels.
3. Move the mouse pointer through each successive right arrow till you reach the hierarchy level you want.

The following figure shows an example of an expanded Merchandise hierarchy level:

Figure 2–2  Browsing through Hierarchies

4. Once you reach the level and node you want, click it.
5. Click the Filter button.

The Business Rules Grid panel (right pane) updates to reflect the hierarchy level you selected.
To traverse back up the hierarchy, move the mouse pointer over the left arrow of the selected hierarchy level, and navigate back to the hierarchy level you want.

**Expanding the Hierarchies Within the Grid**

To expand the hierarchies within the grid:

- In the hierarchy grid, click the blue angle bracket next to the hierarchy level.

  The grid now displays an additional column that contains the next level (for example, Department and all of its nodes Dept. 001, Dept. 002, Dept. 003, and so on). Repeat this step until you expand the hierarchy to the levels you want.

The following figure shows an example of an expanded merchandise hierarchy using this method:

*Figure 2–3 Expanding the Hierarchies*
Locating Your Business Rules

Finding a Hierarchy Entity

You can use the Find feature to navigate to a node (an entity on a hierarchy). Common examples of node identifiers are style, product, or store code, and so on.

For example, on the Department level of the Merchandise hierarchy, some nodes might be Men’s Dept., Women’s Dept., Children’s Dept., Housewares Dept., Sporting Goods Dept., and so on.

To find a hierarchy entity:

1. On the Filters panel, under Merchandise or Location, click Find.

2. From the Find list box, select the level you want. For example, the Find list box for merchandise may include Style and Product. The Find list box for stores may include Region and Store.

Figure 2–4 Finding a Hierarchy Entity

3. In the text box, enter the identifier for the node (for example, style, product, region, store, and so on).

4. Click Filter.

If the node exists, it appears in the grid pane. Otherwise, a message appears indicating that the node could not be found.
Modifying the Business Rule Settings

To modify the business rules:

1. Access the Business Rule Management utility. For more information, see "Understanding the Business Rule Management User Interface" on page 2-4.

2. On the Business Rules screen, scroll horizontally to find the business rule you want.

Figure 2–5 Changing a value in a category

3. Modify the business rule value:

4. When you have changed the business rule values as necessary, click Save.

When you modify the business rule settings, any changes you make are inherited by the lower levels in the hierarchies.

Note: The rule values may be null only if that was set as the default value during implementation. To specify a null value, enter NONE.
Copying the Business Rule Settings

You can copy the business rules settings from one (or more) hierarchy level/attribute combination to another.

Note: Any changes that you make are inherited by the lower levels in the Merchandise and Location hierarchies. There may be some restrictions on the rules that you can copy or paste.

To copy the business rule settings:

1. On the Business Rules screen grid, use the check box next to each rule to select one or more rule sets that you want to copy.
2. From the Action list, select Copy rule values, and click Apply.

   The Copy Business Rules dialog box appears.

3. On the Copy Business Rules dialog box, clear the check boxes for the rule values you do not want to copy, and then click Copy.

4. On the Business Rules screen grid, locate and select the rule set you want to update with the copied values.

5. From the Action list, select Paste rule values, and click Apply.

   The new business rule settings take effect immediately.

Removing the Business Rule Settings

When you delete a business rule setting,

- The rule is not deleted from the Business Rule Management utility. Only the specified values (for a particular level) are removed.
- The values in the inherited levels are replaced with the default values that were set during implementation.

Note: To remove the rule values, you must have the appropriate access privileges to edit the rule values. The following border shades indicate the access privileges for a rule:

- A black cell border indicates that the rule value can be modified.
- A gray cell border indicates that the rule value cannot be modified.

To delete a business rule setting:

1. On the Business Rules screen grid, navigate to the rules that you want to delete.

2. To delete a single rule, select the rule you want, and click Delete.

   Or

   To delete multiple rules, select the rules you want.

   From the Action list, select Delete selected rules, and click Apply.
3. Click Save.

Viewing the History of All the Business Rule Modifications

At any time, you can review the history of all the modifications made to a business rule. The number of prior weeks of history available in the application is determined during the implementation.

To view the business rule history:

1. Access the Business Rules Management utility. For more information, see "Understanding the Business Rule Management User Interface" on page 2-4.

2. On the Business Rules screen grid, select the levels you want to review.

3. From the Action list, select View rule history, and click Apply.

   The Business Rule History dialog box appears.

4. From the Rules list box, select the rule you want, and in the Changes between text boxes, enter the dates for which you want to view the history.

   To view a business rule value that was in effect on a particular date, enter the date you want in both the text boxes.

5. Click View.

   The Business Rule History screen appears with the history for the specified rule at the hierarchy levels.

6. If you want to print or export the rule history, select Print or Export from the Action list, and then click Apply.

7. When you are finished, click Done to return to the Business Rules screen.

About the Business Rule History Screen

The Business Rule History screen is organized by Merchandise and Location hierarchy levels and then by date, with the newest date at the top of each merchandise or location grouping and the oldest date at the bottom of each merchandise or location grouping. This enables you to view how a value was modified over time.

On this screen,

- The Start Dt and End Dt columns show the time period for which the business rule and its value are effective. This can help you to determine if one or more weekly optimizations that have been affected by a particular business rule.

- The User column displays the user name of the person who made the change.
Managing Stores

The Store Set Management Utility enables you to view and change the store sets used in the application. It also enables you to modify the subsets in each store set and add more stores in a subset. This chapter describes the tasks that you can perform to manage the store sets and subsets. It includes the following sections:

- "Understanding Store Sets and Subsets" on page 3-1
- "Accessing the Store Set Management Utility" on page 3-2
- "Managing Store Sets" on page 3-3
- "Managing Subsets" on page 3-9

Understanding Store Sets and Subsets

A store set is a set of stores, grouped into one or more subsets, that a user can create and use in the application by selecting attributes. A subset contains a group of stores that share a characteristic, such as region, climate, fashion segment, ad designation, or a user-specific attribute.

Store sets are classified in the following manner:

- **Dynamic** store sets are created and maintained by using filters. They are automatically updated whenever the Stores Master records are loaded into the application, as the filters are re-applied or as the attributes change. You can change the store set type from Dynamic to Static to prevent automatic updates of the store set. If you manually assign a store to a store set, the store type is automatically set to Static.

- **Static** store sets can be created manually or by using filters. They are not automatically updated; they can only be changed by deliberate user action.

**Note:** You cannot change a store set type from Static to Dynamic.
**Accessing the Store Set Management Utility**

You can access the Store Set Management utility from the application Main Menu. Ensure that your user account includes the appropriate roles that are necessary to access the Store Set Management utility.

To access the Store Set Management utility:

- On the **Main Menu**, click **Store Set Management**.

The **Store Set Library** screen appears, with a list of the store sets you can access. This library provides a point of access to all the actions on the store sets. The following figure shows the Store Set Library screen:

![Store Set Library Screen](image)

**Figure 3–1 Store Set Library Screen**

The following table describes the fields that appear on the Store Set Library grid:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the store set.</td>
</tr>
<tr>
<td># Subsets</td>
<td>Number of subsets assigned to the store set.</td>
</tr>
<tr>
<td>Created By</td>
<td>User ID of the user who created the store set.</td>
</tr>
<tr>
<td>Date Created</td>
<td>Date when the user created the store set.</td>
</tr>
<tr>
<td>Last Used</td>
<td>Date when the store set was last accessed by any user.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the store set (Static or Dynamic).</td>
</tr>
</tbody>
</table>
Managing Store Sets

The Store Set Management user interface enables you to add, modify, or remove store sets, as also the associated stores or subsets. It also enables you to manage the subsets in a store set.

This section describes how you can effectively use the Store Set Management user interface to manage store sets. It includes the following tasks:

- "Creating a New Store Set" on page 3-3
- "Copying the Selected Store Set" on page 3-3
- "Renaming the Selected Store Sets" on page 3-4
- "Merging the Selected Store Sets" on page 3-4
- "Removing the Selected Store Sets" on page 3-5
- "Viewing Other Store Sets" on page 3-6
- "Printing and Exporting the Store Set Information" on page 3-7
- "Sorting the User Account Information" on page 3-7
- "Customizing the Columns" on page 3-8

---

**Note:** As a common user, the functionality of using Store Set Management is limited. You can only view the store set information.

---

Creating a New Store Set

Use the New Store Set feature (in the Action list on the Store Set Library screen) to create new store sets.

To create a new store set:

- On the Store Set Library screen, select New Store Set in the Action list, and then click Apply.

  A new store set named NewStoreSet is created and added to the Store Set Library.

For information on renaming the store set, see "Renaming the Selected Store Sets" on page 3-4.

Copying the Selected Store Set

Use the Copy Selected Store Set (in the Action list on the Store Set Library screen) to copy a store set and create a new store set that includes the same attributes, subsets, and stores assigned to the subsets.

To copy a selected store set:

1. On the Store Set Library screen, select the check box next to the store set you want.
2. From the Action list, select Copy Selected Store Set, and then click Apply.

---

**Note:** You can copy only one store set at a time.

---

A new store set named Copy of store_set_name is created and added to the Store Set Library screen.
For information on renaming the new store set, see "Renaming the Selected Store Sets" on page 3-4. Within the new store set, you can add, merge, remove, or rename the subsets based on your need. You can also add or move stores between the subsets. For more information, see "Managing Subsets" on page 3-9.

Renaming the Selected Store Sets

Use the Rename Selected Store Set feature (in the Action list on the Store Set Library screen) to rename the store sets you want. You can rename more than one store set at a time.

To rename a selected store set:

1. On the Store Set Library screen, select the check box next to the store set you want.
2. From the Action list, select Rename Selected Store Set, and click Apply.
   The Rename Store Set screen appears.
3. Enter the new name for the store set, and click Rename.

   **Note:** Valid characters for naming a store set or a subset are letters, digits, a space, or "_".

Merging the Selected Store Sets

Use the Merge Selected Store Sets feature (in the Action list on the Store Set Library screen) to merge the subsets that belong to each store sets.

You can merge only two store sets at a time. The merged store sets continue to exist independently.

   **Note:** Merged stores sets are Static store sets.

To merge the two existing store sets:

1. On the Store Set Library screen, select the check boxes next to the two store sets you want to merge.
2. From the Action list, select Merge Selected Store Sets, and click Apply.
   A new store set is created and it appears on the Store Set Library screen with the name Store_Set_Name_1-Store_Set_Name_2.
   To merge another store set with the merged store sets, repeat steps 2 and 3.

When you merge two store sets, a new store set is created that includes all possible combinations of the subsets, and one remaining subset (includes the stores that did not belong to any of the possible combinations of the subsets).

**Example 3–1 Merge Store Sets**

Consider that two store sets, Climate and State, exist in the Store Set Management utility. The Climate store set includes the following subsets (4) that group stores according to the weather:

- Cold Winter
- Mild Winter
Managing Store Sets

- Regular Winter
- Remaining Subset

The *State* store set includes the following subsets (4) that group the stores based on the states where the stores are located:

- S1
- S2
- S3
- Remaining Subset

When you merge these two store sets, a new store set, *Climate-State*, is created. It includes the following subsets (10):

- Cold Winter-S1
- Cold Winter-S2
- Cold Winter-S3
- Mild Winter-S1
- Mild Winter-S2
- Mild Winter-S3
- Regular Winter-S1
- Regular Winter-S2
- Regular Winter-S3
- Remaining Subset

**Removing the Selected Store Sets**

Use the *Remove Selected Store Sets* feature (in the Action list on the Store Set Library screen) to remove the store sets from the application.

To remove the selected store set:

1. On the *Store Set Library* screen, select the check box next to the store set you want.
2. From the *Action* list, select *Remove Selected Store Set*, and click *Apply*.

---

**Note:** Once a store set is removed, the store set cannot be retrieved from the database. The store sets created by a user can be deleted or removed from the application only by that user.
Viewing Other Store Sets

Use the View Other Store Sets feature (in the Action list on the Store Set Library screen) to view the store sets created by other users in the application. It also enables you to search and add a copy of the other store sets for your user account.

**Note:** You can view all the store sets in the database. However, you cannot delete or modify any of the store sets created by the other users.

To view the other store sets:

1. On the Store Set Library screen, select View Other Store Sets in the Action list, and click Apply.
   The View Other Store Sets screen appears.

2. Enter the user name in the User Name field
   Or
   Enter the store set name in the Store Set Name field.

   **Note:** You can enter the user name and the store set name to find the store set.

3. Click Find.

4. The store set(s) that match your search criteria are displayed in the list.

   The store set(s) appear in the library with the name of the user who created the store set, the store set ID, the date when it was created, the date when it was last used, and the type of store set.

   You can add this store set in the Store Set Library by clicking on Add Store Sets button on the top panel. The following figure shows the View Other Store Sets window with the search results.

   ![View Other Store Sets Screen](image)

   **Figure 3–2 View Other Store Sets Screen**

To add the store set to the Store Set Library:

1. Select the check box next to the store set that you want to add to your Store Set Library.

2. Click Add Store Sets on the top panel of the screen.
Printing and Exporting the Store Set Information

Use the *Print or Export* feature (in the Action list on the Store Set Library screen) to print or export the information that appears on the Store Set Library grid. When you print or export the information:

- Only the visible columns are printed or exported. For example, if you choose to hide some columns (see “Customizing the Columns” on page 3-8), the data in those columns are excluded in the output.
- The information is printed or exported in the current sort order. (To change the sort order, see “Sorting the User Account Information” on page 3-7.)

**Note:** You can export the information in the Microsoft Excel (.xls) format.

To print or export the store set information:

1. On the *Main Menu*, click *Store Set Management*.
   
   The *Store Set Library* screen appears.

2. From the *Action* list, select *Print or Export*, and then click *Apply*.

   The *Print or Export* dialog box appears with a reminder that only the visible data (not the data in the hidden columns) will be printed or exported. The dialog box also includes a count of the rows and the columns. This can help you decide how long the print or export process will take.

3. Do one of the following:

   **Table 3–2  Printing and Exporting User Account Information**

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print the user data on the screen</td>
<td>1. Click <em>Print</em>.</td>
</tr>
<tr>
<td>(not the screen itself)</td>
<td>2. Enter the appropriate print parameters in the <em>Print</em> dialog box</td>
</tr>
<tr>
<td></td>
<td>that appears.</td>
</tr>
<tr>
<td>Export the data to a Microsoft Excel</td>
<td>1. Click <em>Send to Excel</em>. The <em>Save As</em> dialog box appears.</td>
</tr>
<tr>
<td>spreadsheet</td>
<td>2. Type a file name, and click <em>Save</em>. An Export Complete message</td>
</tr>
<tr>
<td></td>
<td>appears along with the path and file name of the file, and the</td>
</tr>
<tr>
<td></td>
<td>Microsoft Excel file opens.</td>
</tr>
</tbody>
</table>

Sorting the User Account Information

Use the *Sort Table* feature (in the Action list on the Store Set Library screen) to sort the store set information that appears on the Store Set Library grid.

To sort the store set information:

1. From the *Action* list, select *Sort Table*, and click *Apply*.

   The *Customize Table* dialog box appears.

2. On the *Sort Table* tab, enter a sort criteria in the following manner:

   a. Select a column from the first list box. This column becomes the primary sort column for the data display.

   b. For that column, select a sort order, either ascending order (A - Z or 1 - 10) or a descending order (Z - A or 10 - 1).
c. If you want to sort the data by additional columns, select a column and sort order for the remaining two list boxes.

**Note:** To remove one or more criteria, click *Select* from the list boxes.

3. When the list boxes and sort order reflect the way you want the data to be sorted, click **Done**.

### Customizing the Columns

Use the *Modify Columns* feature (in the Action list on the Store Set Library screen) to customize (rearrange or hide) the columns that appear on the Store Set Library grid.

To customize the columns:

1. From the **Action** list, select **Modify Columns**, and click **Apply**.

   The **Customize Table** dialog box appears.

2. On the **Change Columns** tab, do one of the following:

   **Table 3–3  Customizing Columns**

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide a column</td>
<td>1. In the <strong>Visible Columns</strong> list, select the column that you want to hide.</td>
</tr>
<tr>
<td></td>
<td>2. Click the left arrow to move the column to the <strong>Hidden Columns</strong> list.</td>
</tr>
<tr>
<td>Show a hidden column</td>
<td>1. In the <strong>Hidden Columns</strong> list, select the column that you want to make visible.</td>
</tr>
<tr>
<td></td>
<td>2. Click the right arrow to move the column to the <strong>Visible Columns</strong> list.</td>
</tr>
<tr>
<td>Change the column order</td>
<td>1. In the <strong>Visible Columns</strong> list, select the column whose position you want to change.</td>
</tr>
<tr>
<td></td>
<td>2. Click the up or down arrow until the column is in its target location.</td>
</tr>
</tbody>
</table>

3. When the **Customize Table** dialog box reflects your settings, click **Done**.
Managing Subsets

A subset is a group of stores, grouped because of a similar attribute or characteristic. There can be many stores in a subset and multiple subsets assigned to a store set.

This section describes how you can effectively manage subsets, using the features available in the following tabs:

- "Subsets Tab" on page 3-9
- "Filters Tab" on page 3-14
- "Stores Tab" on page 3-17

Subsets Tab

The Subsets tab lists all the subsets that belong to the store set. It enables you to add, rename, combine, and remove the subsets.

On the Subsets tab, you can perform the following tasks:

- "Creating a New Subset" on page 3-11
- "Renaming the Selected Subsets" on page 3-11
- "Combining the Selected Subsets" on page 3-11
- "Removing the Selected Subsets" on page 3-12
- "Changing the Store Set Type to Static" on page 3-13
- "Adding Specific Stores to the Subset" on page 3-13
- "Customizing the Table" on page 3-13
- "Printing or Exporting Information" on page 3-13

Subsets Tab Screen

The following figure shows the Subsets tab in the Store Set screen:
Subsets Tab Components

The following table describes the components in the Subsets tab:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action list</td>
<td>The Action list includes the options that enable you to perform the following administrative tasks:</td>
</tr>
<tr>
<td></td>
<td>• “Creating a New Subset” on page 3-11</td>
</tr>
<tr>
<td></td>
<td>• “Renaming the Selected Subsets” on page 3-11</td>
</tr>
<tr>
<td></td>
<td>• “Combining the Selected Subsets” on page 3-11</td>
</tr>
<tr>
<td></td>
<td>• “Removing the Selected Subsets” on page 3-12</td>
</tr>
<tr>
<td></td>
<td>• “Changing the Store Set Type to Static” on page 3-13</td>
</tr>
<tr>
<td></td>
<td>• “Customizing the Table” on page 3-13</td>
</tr>
<tr>
<td></td>
<td>• “Printing or Exporting Information” on page 3-13</td>
</tr>
<tr>
<td>Subset Grid</td>
<td>The Subset grid displays the information on the subsets included in the store set.</td>
</tr>
<tr>
<td>Add Stores Area</td>
<td>The Add Stores area enables you to add individual stores to a specific subset. For more information, see “Adding Specific Stores to the Subset” on page 3-13.</td>
</tr>
</tbody>
</table>
Creating a New Subset
Use the New Subset feature (in the Action list on the Subsets tab) to create new subsets.

To create a new subset:

1. On the Store Set Library screen, select the store set in which you want to add a new subset.
   The Store Set screen appears.

2. On the Subsets tab, select New Subset in the Action list, and click Apply.
   The new subset appears in the Subset grid with the name New SubSet. If you have already created a subset with that name, the new subset gets named as New SubSet1. You can change the name of the subset to an appropriate name. For more information on how to change the name of the subset, see "Renaming the Selected Subsets" on page 3-11.

Renaming the Selected Subsets
Use the Rename Selected Subsets feature (in the Action list on the Subsets tab) to rename the subsets you want.

To rename a selected subset:

1. On the Store Set Library screen, select the store set that contains the subset you want.
   The Store Set screen appears.

2. On the Subsets tab, select the subset you want.

3. From the Action list, select Rename Selected Subsets, and click Apply.
   The Rename Subsets window appears.

4. Enter the new subset name in the Rename Subset to field, and click Rename subset.

Combining the Selected Subsets
Use the Combine Selected Subsets feature (in the Action list on the Subsets tab) to include all the stores, present in two different subsets, into a new subset and replace the two existing subsets.

---

Note: You can combine only two subsets at a time.

---

To combine the selected subsets:

1. On the Store Set Library screen, select the store set that contains the subsets you want to combine.
   The Store Set screen appears.

2. On the Subsets tab, select the two subsets that you want to combine by selecting the check box next to each subset.

3. Click Apply.
   A confirmation message appears.
Managing Subsets

---

**Note:** When you combine two subsets, the store set is automatically set to Static.

4. Click OK.

The combined subset appears on the Subsets grid, with the name that is a combination of the names of the two subsets, and includes the stores that were attached to the subsets. It does not include the previous filter condition used to include the stores in the subsets.

**Example 3-2 Combining Subsets**

Consider that the State store set includes the following subsets (4) that group the stores based on the states where the stores are located:

- S1 (includes 4 stores)
- S2 (includes 6 stores)
- S3 (includes 2 stores)
- Remaining Subset

When you combine the S1 and S2 subsets, a new S1-S2 subset is created that replaces the two subsets, and includes 10 stores.

**Removing the Selected Subsets**

Use the Remove Selected Subsets feature (in the Action list on the Subsets tab) to remove subsets from a store set.

To remove selected subsets from a store set:

1. On the Store Set Library screen, select the store set that contains the subset you want.

   The Store Set screen appears.

2. On the Subsets tab, select the subset that you want to remove, and then click Apply.

   A confirmation message appears.

3. Click OK.

When you remove a subset, stores in the subset get added to the Remaining Subset subset.

To assign the stores to another subset,

- Apply filter conditions (see "Adding Stores to the Subsets using Filters" on page 3-15)

  Or

- Add the stores to a subset manually (see "Adding Specific Stores to the Subset" on page 3-13).

---

**Note:** Once removed, you cannot retrieve any information on the subset.
Changing the Store Set Type to Static
Use the Change Store Set Type to Static feature (in the Action list on the Subsets tab) to change the store set type to Static and prevent automatic updates to the store sets (by means of the filters).

To change the store set type to Static:
1. On the Store Set Library screen, select the store set you want.
   The Store Set screen appears.
2. On the Subsets tab, select Change Store Type to Static in the Action list, and click Apply.
   A confirmation message appears.
3. Click OK.

Adding Specific Stores to the Subset
Use the Add Stores to Selected Subset button (on the Subsets tab) to add individual stores to the selected subset. You can also replace the existing stores in a subset with the stores you want, using the Replace Existing Stores check box.

To add or replace the stores in a store subset:
1. On the Store Set Library screen, select the store set you want.
   The Store Set screen appears.
2. On the Subsets tab, select the check box next to the subset you want.
3. In the text box (Add Stores area) to the right, enter the store IDs of the stores. See Figure 3–3, "Subsets Tab in the Store Set screen"
4. Click Add Stores to Selected Subset.

Select the Replace Existing Stores check box to move the stores in the store set to Remaining Subset, and add the store (s) you listed in the text area to the store set.

Customizing the Table
You can change the display of the subsets listed within the Subsets tab by using the Customize Table option. For more information, see "Sorting the User Account Information" on page 3-7 and "Customizing the Columns" on page 3-8.

Printing or Exporting Information
You can print the information displayed on the screen or export the information to a Microsoft Excel spreadsheet. For information on how to print or export data, see "Printing and Exporting the Store Set Information" on page 3-7.
Filters Tab

The Filters tab lists the filters that are used to include the stores in each subset. It enables you to add stores to a subset for a specific set of conditions, and also move the stores between the subsets by rearranging the filter conditions.

On the Filters tab, you can perform the following tasks:

- "Adding Stores to the Subsets using Filters" on page 3-15
- "Rearranging Stores in the Subsets" on page 3-16

**Note:** To effectively use the Filter feature, you must have at least two subsets (other than the remaining subset) in a store set.

Filters Tab Screen

The following figure shows the Filters tab in the Store Set screen:

*Figure 3–4  Filters Tab in the Store Set Screen*
Filters Tab Components
The following table describes the components in the Filters tab:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply Filters</td>
<td>Click the Apply Filters button to apply the filter conditions specified for the subsets. For more information, see &quot;Adding Stores to the Subsets using Filters&quot; on page 3-15.</td>
</tr>
<tr>
<td>Reorder Subsets</td>
<td>Click the Reorder Subsets button to rearrange the stores in each subsets by modifying the sequence in which the conditions are specified. For more information, see &quot;Rearranging Stores in the Subsets&quot; on page 3-16.</td>
</tr>
<tr>
<td>Filter Grid</td>
<td>The Filter grid displays the filter conditions used for the subsets. For more information on working with the Filters grid, see &quot;Adding Stores to the Subsets using Filters&quot; on page 3-15 and &quot;Rearranging Stores in the Subsets&quot; on page 3-16.</td>
</tr>
</tbody>
</table>

Adding Stores to the Subsets using Filters
Use the Apply Filters button (on the Filters tab) to add stores to the subsets based on a sequence of filter conditions.

To add stores to a subset by specifying a filter:

1. On the Store Set Library screen, select the store set you want.
   The Store Set screen appears.

2. On the Filters tab, under If this is true:, select a filter option you want to use, and click Add.
   The Store Set screen updates with the filter condition included in the If this is true: column.

3. Enter an appropriate value for the filter condition.
   To add more filter conditions to each subset, repeat steps 3 – 4.

4. Click Apply Filters.
   The Store Set screen updates with the number of stores in the # Stores column for each subset.

   Note: To ensure that you see the correct number of stores for a specific filter, you must click the Apply Filters button each time you modify the value of filter condition.

To remove a filter condition:

1. Under If this is true, select the check box next to the filter condition you want to remove from the subset.

2. Click Clear.
   The Store Set screen updates with the filter condition excluded from the subset.
Rearranging Stores in the Subsets
Use the **Reorder Subsets** button (on the Filters tab) to rearrange the store groupings in the subsets by modifying the sequence of filter conditions.

To rearrange the stores assigned to each subset:

1. On the **Store Set Library** screen, select the store set you want.
   - The **Store Set** screen appears.
2. On the **Filters** tab, click **Reorder Subsets**.
   - The **Reorder Subsets** screen appears.

**Figure 3–5  Reorder Subsets Screen**

3. In the **Subsets** list, select the subset you want to move, and use the Up or Down arrows to change it’s position.
4. Click **Reorder**.

   The Store Set screen updates with the revised store count in each subset.
Stores Tab

The Stores tab lists all the stores that belong to the store set. It enables you to select the stores, and move the stores to the subsets you want.

On the Stores tab, you can perform the following tasks:

- "Finding Stores" on page 3-18
- "Moving Stores to a Different Subset" on page 3-18

Stores Tab Screen

The following figure shows the Stores tab in the Store Set screen:

*Figure 3–6 Stores Tab in the Store Set Screen*
Stores Tab Components
The following table describes the screen components in the Stores Tab:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Lists</td>
<td>Use the following lists, in the Filter Lists area, to specify a filter and view a set of stores in the Store grid:</td>
</tr>
<tr>
<td></td>
<td>■ Subset</td>
</tr>
<tr>
<td></td>
<td>■ State</td>
</tr>
<tr>
<td></td>
<td>■ Climate</td>
</tr>
<tr>
<td></td>
<td>■ Region</td>
</tr>
<tr>
<td></td>
<td>■ Ad Desg</td>
</tr>
<tr>
<td></td>
<td>■ Division</td>
</tr>
<tr>
<td></td>
<td>Once you set the relevant options, click Show to view the set of stores you want.</td>
</tr>
<tr>
<td>Move List</td>
<td>The Move List list enables you to specify the subset where you want to place the stores you want. For more information, see &quot;Moving Stores to a Different Subset&quot; on page 3-18.</td>
</tr>
<tr>
<td>Action list</td>
<td>The Action list includes options that enable you to perform the following administrative tasks:</td>
</tr>
<tr>
<td></td>
<td>■ &quot;Finding Stores&quot; on page 3-18</td>
</tr>
<tr>
<td></td>
<td>■ &quot;Customizing the Table&quot; on page 3-19</td>
</tr>
<tr>
<td></td>
<td>■ &quot;Printing or Exporting Information&quot; on page 3-19</td>
</tr>
<tr>
<td>Store Grid</td>
<td>The Store grid displays the information on all the stores included in the store set.</td>
</tr>
</tbody>
</table>

Finding Stores
Use the Find Store feature (in the Action list on the Stores tab) to find a specific store in the Store grid.

To find a store in the Store grid:

1. On the Store Set Library screen, select the store set in which you want to search for the store.
   The Store Set screen appears.
2. On the Stores tab, select Find Store in the Action list, and click Apply.
   The Find Store screen appears.
3. Type the Store ID for the store you want, and click OK.
   The Store grid updates with the store highlighted in the color red.

Moving Stores to a Different Subset
Use the Move List (on the Stores tab) to move a set of stores to a different subset.

To move a set of stores to a different subset:

1. On the Store Set Library screen, select the store set you want.
   The Store Set screen appears.
2. On the Stores tab, select the check box next to the stores you want.
3. In the Move List list, click the subset where you want to place the selected stores, and then click Move. A confirmation message appears.

4. Click OK.

Customizing the Table
You can change the display of the stores listed within the Stores tab by using the Customize Table option. For more information, see "Sorting the User Account Information" on page 3-7 and "Customizing the Columns" on page 3-8.

Printing or Exporting Information
You can print the information displayed on the screen or export the information to a Microsoft Excel spreadsheet. For information on how to print or export data, see "Printing and Exporting the Store Set Information" on page 3-7.
Managing Reports

The Merchant Desktop reporting utility uses the MicroStrategy Web Universal platform, and enables you to create reports required by your business. Users can then copy the reports you create, modify them, and save them to their own directories. This chapter describes the tasks you can perform, as an administrator, to manage the reports.

This chapter includes the following sections:

- "About Merchant Desktop" on page 4-1
- "Post-Installation Configuration" on page 4-2
- "Administrative Tasks" on page 4-5
- "Working with the Reports" on page 4-28
- "Personalizing Merchant Desktop" on page 4-38
- "Troubleshooting" on page 4-46
- "Good Practices" on page 4-49

Your access to MicroStrategy Web Universal is seamless. Once you log on to Merchant Desktop, you are logged on to MicroStrategy Web Universal platform.

When you access reports or graphs, you can also access the MicroStrategy help for more additional information on using the Merchant Desktop features.

About Merchant Desktop

Merchant Desktop is a reporting utility that helps you access the reports set up for the application. It uses the Microstrategy Intelligence Server™ and the Web Universal platform, and provides features that help you export the report information in different formats, including the PDF format. It also helps you to subscribe to a report, at a specific interval.

Administrative Roles

The following administrative roles are available for Merchant Desktop:

- MD_ADMINISTRATOR – Administrators have all access to the Merchant Desktop and MicroStrategy web professional privileges.
- MD_REPORT_ADMIN – Report administrators have access to the personalization features within the Merchant Desktop and MicroStrategy Web Professional.
Accessing Merchant Desktop

You can access the Merchant Desktop utility from the main menu of the application. Ensure that your user account includes the roles that are necessary to access the Reports utility.

To access the Reports utility:

- On the Main Menu, click Reports.

  The Merchant Desktop screen appears, with a list of the features that you can access.

Post-Installation Configuration

MicroStrategy provides an export to PDF option that is not supported on all of the Merchant Desktop platforms. Once the Merchant Desktop is installed, you must ensure that the export to PDF is not available to users. In addition, you must also set up the history list option.

To set up the Export and History list options:

1. Start the MicroStrategy Desktop application.

   The MicroStrategy Desktop application screen appears.

2. Copy a user with the role of MD_ADMINISTRATOR from the Everyone group to the System Administrators group.

3. Open a new browser window, type in the Merchant Desktop URL, and log on as the user you just copied in the MicroStrategy Desktop.

   The following screen appears:
4. Click the Preferences button or link.

5. On the left-hand side of the screen, locate the Preferences Level menu, and then click the Project Defaults link.

6. Still on the left-hand side of the screen, locate the Preferences menu, and then click the History List link.

7. Ensure that the Manually option is selected, and change the value of the number of reports you want to display for manipulation to at least 6 (See Figure 4–3).

Figure 4–3  Merchant Desktop - Update Confirmation Screen

8. Click the Apply button at the bottom left of the screen.

9. Again on the left-hand side of the screen, locate the Preferences menu, and then click the Export link.
The following screen appears (See Figure 4–4).

**Figure 4–4 Merchant Desktop - Export Screen**

10. Scroll down to the bottom of the screen, and clear the Enable export to PDF check box (See Figure 4–5).

**Figure 4–5 Enable export to PDF Option**

11. Click the **Apply** button at the bottom left of the screen.

12. Log out of Merchant Desktop.

13. Go back to MicroStrategy Desktop, and remove the user that you added in step 2 from the System Administrators group.

Users will now have a history list of at least 6 reports (depending on the value you entered), and the Export to PDF option will not be available to users.
Administrative Tasks

Following is a high-level list of Merchant Desktop administration tasks. You can perform the following tasks after a successful installation of Merchant Desktop:

- Managing user accounts - Depending on your implementation of Merchant Desktop and the Oracle Retail application, the user accounts may already be created for you by Oracle Retail professional services. You can use the User Management utility to add, modify, or inactivate (remove) user accounts.

  When users log on and no view is assigned to them, the following message appears:

  Either the View you have been assigned is empty or you are not currently assigned a view. Please contact your administrator for assistance.

  If you want to customize this message to include a name, phone number, or E-mail address or something else, see "Updating the Unassigned View Message" on page 4-6.

- Managing views screens, and components - This task involves several procedures, and there are several ways to get started as explained in "Getting Started with Views and Their Elements" on page 4-7. After you have assigned views to users, see "Understanding Updates" on page 4-8 to understand the effect of updates you make.

- Managing reports - This task involves using the MicroStrategy Desktop or Web Universal application to create reports, or to modify any of the reports and graphs that are supplied with Merchant Desktop.

- Managing desktops - This task involves making sure end user browsers are set up correctly. See the section Checking Your Merchant Desktop Browser Settings in the application User’s Guide. Use these settings on the administrative computer as well.

About Views, Screens, and Components

A view is the collection of screens and their components that appear on each user’s Merchant Desktop. You can create the views, screens, and components in any order, but it is helpful if you understand how they relate to each other:

- Components are the building blocks of screens, and they contain the actual content. They appear as individual windows on each screen.

- Screens are the building blocks of views, and they serve as containers for components.

- Views are the "packages" that hold the screens (basically, a row of screen tabs). Views are what you deploy to Merchant Desktop users.

Below is a sample view that would be deployed to a user. It has five screens (Home, Forecasts, Markdowns, My Reports, and Reporting), and the Home screen has five components. The pencil buttons indicate that this view is for a power user.
Updating the Unassigned View Message

You can customize the message that appears for users with no assigned views or no screen assigned to the view.

To customize the message:

1. Retrieve the UnassignedUser.html file from one of the following locations, depending on which application server your site is using. If your application server is installed to a different location, use that path instead.

   WebLogic:
   
   ../modules/MerchantDesktop/MerchantDesktop.ear/dashboard.war/html/UnassignedUser.html

   WebSphere:
   
   ../WebSphere51/installedApps/servername/MerchantDesktop.ear/dashboard.war/html/UnassignedUser.html

2. Modify the HTML using a text or HTML editor.

   An alternative is create a new HTML file using an HTML editor, but you must name it with the same name and capitalization: UnassignedUser.html

3. Copy the new or updated file to the same location in step 1.

   The new HTML is available as soon as the file is copied.
Getting Started with Views and Their Elements

You can start working with the Merchant Desktop Views, and the associated elements, in one of the following ways:

- Copy the sample views, screens, and components supplied with Merchant Desktop and modify them as you want before you deploy them to users. See "Modifying and Deploying Sample Views and Their Elements" on page 4-7.
- Create all of your own components, screens, and views. See "Creating and Deploying Views and Their Elements" on page 4-8.

Modifying and Deploying Sample Views and Their Elements

The Merchant Desktop module includes some sample views, screens, and components that you can use to create your own views, and then deploy them to the users.

To modify the sample views (and the associated elements), and deploy them to the users:

1. If you haven’t already done so, create one or two test user accounts so that you can review the samples. See "Creating a User Account" on page 1-7.

2. Assign a sample view to one of the user accounts you just created. See "Assigning a View to a User" on page 4-12.

   All sample views are named with a "pl - " prefix. Sample views are provided for common roles in retail organizations, such as Buyers and GMMs.

3. Open a new Web browser window (do not open a browser window by selecting File > New > Window) and log on with the user account to which you just assigned the view.

4. Review the screens and components on this view to familiarize yourself with what you like and what you want to change.

5. If you are the only administrator and you are not concerned about preserving the samples as they are, you can modify them directly. This allows you to use the views as they are without having to assign newly created or copied screens, and to use the screens without having to add newly created or copied components.

   If there are other administrators and you want to preserve the samples, make a copy of what you want to change first. To make a copy of a view, screen, or component, click the Copy link on the corresponding View, Screen, or Component Administration screen.

6. Modify and save each view, screen, or component as necessary.

7. If you copied the components, add them to screens, and if you copied the screens, add them to a new or copied view. See the following:

   - "Adding Components to a Screen" on page 4-18
   - "Adding Screens to a View" on page 4-12

8. Test the view by assigning it to one of your test user accounts, opening a new browser instance, and logging on as that user. If you want to update a parameter:

   a. Switch to the browser window where you are logged on as an administrator.
   b. Make the change(s).
   c. Switch back to the test user account browser window.
   d. Click the changed view, screen, or component to see the change.
Administrative Tasks

9. When you are satisfied with the view, assign it to users as explained in "Assigning a View to a User" on page 4-12.

10. After you assign views to users, see "Understanding Updates" on page 4-8 to understand which updates affect power user accounts. Standard user accounts receive all administrative updates.

Creating and Deploying Views and Their Elements

If you want to start from scratch, here is a comprehensive and sequential list of all of the tasks involved in creating your own components, screens, and views and deploying them to users.

1. Create one or more components. See "Creating a Component" on page 4-20.

2. Create one or more screens. See "Creating a Screen" on page 4-14.

3. Add one or more components to each screen. See "Adding Components to a Screen" on page 4-18.

4. Create one or more views. See "Creating a View" on page 4-10.

5. Add one or more screens to each view. See "Adding Screens to a View" on page 4-12.

6. Assign each view to one or more users. See "Assigning a View to a User" on page 4-12.

All of these procedures assume you are logged on to Merchant Desktop with full administrative privileges.

Understanding Updates

After assigning the views to users, you may want to change the views by adding new screens, updating components, and so on. For standard users, the changes appear automatically the next time users click the affected element (view, screen, or component) or the next time they log on. Administrative updates do not affect the personalization done by the power users.

The following table summarizes the differences for standard users and power users:

<table>
<thead>
<tr>
<th>User account type</th>
<th>Effect of administrative updates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard user</td>
<td>Users will automatically receive all of your changes the next time they click the affected element (view, screen, or component), or they will receive the changes the next time they log on.</td>
</tr>
<tr>
<td>(Read-only with no personalization privileges)</td>
<td></td>
</tr>
</tbody>
</table>

Note: You must open separate instances of the browser by starting Internet Explorer. Opening a browser window via File > New > Window will not work because then two instances of the browser are sharing one Merchant Desktop session.
Forcing Updates

You can force updates to power users. However, you must be aware that forcing updates to power users overwrites all of the personalizations that they have made. Once you have forced an update, there is no way to retrieve the power user’s personalizations.

Caution: Forcing an update overwrites all personalizations that the power user has made. If you do need to force an update, remove the assigned view from the power user and then reassign it.

View Administration

The View Administration screen lists sample views supplied with Merchant Desktop (denoted by the "pl - “ prefix), and those created by you and other administrators. Views created by other administrators appear only when those administrators have selected the Allow All Administrators To Access check box for one or more views.

All of the views on this list can be assigned to one or more users. Use the View Administration screen as a starting place to do the following:

- "Creating a View” on page 4-10
- "Copying a View” on page 4-11
- "Editing a View” on page 4-11
- "Deleting a View” on page 4-11
- "Adding Screens to a View” on page 4-12
- "Assigning a View to a User” on page 4-12 – to show or hide a view to/from other Merchant Desktop administrator view lists

View Administration Screen Fields

The following table describes the fields on the View Administration screen:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create View Link</td>
<td>Click this link to create a new view. The Create View screen appears.</td>
</tr>
</tbody>
</table>
Creating a View

A view is a list of one or more screens that users are allowed to access. When users log on to Merchant Desktop, the view appears immediately after a successful login. For each view, you must select a skin (color scheme) and a home screen (the screen that will have the focus when users first log on).

Each user can be assigned only one view.

To create a view:

1. On the View Administration screen, click the Create View link.
   
   The Create View screen appears.

2. Complete the Create View screen with the internal ID and description.
   
   The user sees only the description. The ID and description appear on administration screens to help you distinguish between the different views that you create.

3. When the Create View screen reflects the setting you want, click Save.
The View Administration screen appears, and the new view appears in alphabetical order in the ID column. Before you and users can access it, you must assign screens to the view and then assign the view to users.

**Copying a View**

To create a new view by copying the settings from an existing view:

1. On the View Administration screen, click the Copy link for the view you want.
   
   The Copy View screen appears.

2. On the Copy View screen, type a new view ID in the ID field.

3. In the View IDs Already In Use By You field, select the view you want.

4. Click Save.

**Editing a View**

To edit an existing view:

1. On the View Administration screen, under the ID column, click the view you want.
   
   The Edit View screen appears.

2. Enter appropriate information in the fields, and click Save. The following table describes the fields in the Edit View screen:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Identification number for the view.</td>
</tr>
<tr>
<td>Description</td>
<td>Description text for the view.</td>
</tr>
<tr>
<td>Skin</td>
<td>Select a skin (color theme) for the entire view.</td>
</tr>
<tr>
<td>Allow Personalization</td>
<td>Click this check box to make the relevant field available for personalization.</td>
</tr>
<tr>
<td>Available Screens and Screens in Use</td>
<td>Use these lists to add or remove screens from the view.</td>
</tr>
<tr>
<td></td>
<td>To change the order of the screens, click a screen name and then click the Top, Up, Down, or Bottom buttons until the screen name is in the target position.</td>
</tr>
</tbody>
</table>

**Deleting a View**

To delete a view:

1. On the View Administration screen, click the Delete link for the view you want.
   
   The Delete View screen appears.

2. On the Delete View screen, review the users accounts that will be affected once you delete the view, and then click Delete.

---

**Caution:** There is no undo function. If you delete a view and later want to use it, you must recreate it. In addition, deleting a view removes it from the entire Merchant Desktop system. This means that the view is deleted from all administrators as well as users.
Assigning a View to a User

To assign a view to a user:

1. On the View Administration screen, click the Assign link for the view you want.
   The Assign View screen appears.

2. On the Assign View screen, in the Available Users list, select the user you want.
   Press and hold the CTRL key to select multiple users.

3. Once you select the users, click the Assign button. The Users Assigned This View list now reflects the users assigned to the view.
   An * (asterisk) preceding the user name indicates that user is already assigned a view. The assigned view appears in (parentheses) after the user name.

---

Note: You can assign only one view to a user name. If a UserView1 is assigned to a user name and you then assign UserView2 to that same user name, UserView2 will become the default view the next time that user logs on.

---

Adding Screens to a View

You can add as many screens as you want to a view. If you plan to add several screens to a view, consider making the screen names as short as possible. Each screen name appears on the tabs in the view, so making the screen names short will help to minimize the amount of horizontal scrolling users must do to see all of the screen tabs in the view.

To assign a screen to a view:

1. On the View Administration screen, under the ID column, click the view you want.
   The Edit View screen appears.

2. From the Available Screens list, select the screen you want.
   To select multiple screens, click a screen name, press and hold the CTRL key, and click the names of the other screens you want.

3. Once you have selected the screen(s) you want to assign to this view, click the Add button.
   The screen name(s) move to the Screens In View list.

4. When the Screens In View list reflects all of the screens you want to add, click the Save button.
   The View Administration screen appears.
Screen Administration

The Screen Administration screen lists sample screens supplied with Merchant Desktop (denoted by the "pl -" prefix) and those created by you and other administrators. Screens created by other administrators appear only when those administrators have selected the Allow All Administrators To Access check box for one or more screens.

All of the screens on this list can be assigned to one or more views. Use the Screen Administration screen as a starting place to do the following:

- "Creating a Screen" on page 4-14
- "Copying a Screen" on page 4-18
- "Editing a Screen" on page 4-18
- "Deleting a Screen" on page 4-18
- "Adding Components to a Screen" on page 4-18 – to show or hide screens to/from users’ and other administrators’ lists of screens

Screen Administration Screen Fields

The following table describes the fields in the Screen Administration screen:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Screen Link</td>
<td>Click this link to create a new screen. The Create Screen screen appears.</td>
</tr>
<tr>
<td>Allow Users To Add</td>
<td>Click this check box to make the screen available to all users.</td>
</tr>
<tr>
<td>Allow All Administrators To Access</td>
<td>Click this check box to share the screen with other administrators.</td>
</tr>
<tr>
<td></td>
<td>This means that the screen is available for copying, editing, or deleting by other administrators, and that when one administrator makes a change, all administrators receive that change. If multiple administrators are editing the same screen at the same time, only the last-saved version is preserved.</td>
</tr>
<tr>
<td>ID</td>
<td>Indicates the identification number (ID) assigned to the screen. Each screen name in the ID column is a link to the Edit Screen where you can modify all of the screen settings except for layout. Screens with the &quot;pl -&quot; prefix are samples supplied with Merchant Desktop. To preserve these screens for other administrators, copy them before modifying them.</td>
</tr>
<tr>
<td>Display Name</td>
<td>The text that appears on the tab of each screen in the view.</td>
</tr>
<tr>
<td>Description</td>
<td>This column displays the description text entered for the screen (on the Create Screen or Edit Screen screens). To change the description, click the screen name and enter a new description on the Edit Screen screen.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click this link to copy settings from an existing screen to a new screen ID. The Copy Screen screen appears.</td>
</tr>
</tbody>
</table>
Creating a Screen
A screen is a container for components. It consists of a name and a layout.
Depending on the layout, some screens can be assigned a maximum of six components. The one-column, two-column, and three-column open layouts can be assigned as many components as you want.

To create a screen:

1. On the Screen Administration screen, click the Create Screen link.
   The Create Screen screen appears.

2. On the Create Screen screen, select a relevant screen type and layout, enter the screen ID, Display Name, and Description. For more information on screen types and layouts, see "Screen Types" on page 4-14 and "Screen Layouts" on page 4-15.

3. Click Save.
   The Screen Administration screen appears, and the new screen appears in alphabetical order in the ID column. You (and end users) cannot view it, however, until you add the screen to a view and then assign the view to a user.

Screen Types
Select one of the following screen types:

Table 4–5  Screen Types

<table>
<thead>
<tr>
<th>Screen type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>The Standard screen is the most flexible of all of the screen types. For each standard screen, you can select a variety of pre-defined screen layouts, and you can add all of the components.</td>
</tr>
</tbody>
</table>
Screen Layouts
Select one of the following layouts, which determines the number of components and where you can place them on screens. Note that there are two types of layouts in the list:

- **Fixed layouts** - These layouts can contain from one to a set number of components. Their names begin with "Layout", and the maximum number of components is the highest number in the thumbnail representations (see the table below).

- **Open layouts** - These layouts can contain an unlimited number of components. They are named One Column, Two Column, and Three Column.

For example, Layout 8, which has three columns, can hold only three components (i.e., one row of three components). The Three Column layout, on the other hand, has three columns but can hold an unlimited number of components (i.e., there can be several rows of components).

### Table 4-5 (Cont.) Screen Types

<table>
<thead>
<tr>
<th>Screen type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance</td>
<td>The Performance screen is a special screen type that consists of the &quot;Filtered Graph Component&quot; on page 4-25. The Filter component provides the merchandise, location, and time hierarchies by which you can dynamically update special reports and graphs. (You must create a series of filters for any reports or graphs that you want to interact with the Filter component.) The Filtered Report and Filtered Graph components are designed to display the special reports and graphs and to interact with the merchandise, location, and period trees provided by the Filter component. For each Performance screen, you can select a variety of pre-defined screen layouts, and you add any component. For example, even though only the Filtered Report and Filtered Graph components interact with the Filtered component, you might want to add a web site or news feed to the Performance screen.</td>
</tr>
<tr>
<td>Top/Bottom</td>
<td>The Top/Bottom screen type provides a quick and easy way for users to access the top or bottom n percent of a variety of metrics. For example, you could select to view the bottom 20% of styles (from the merchandise hierarchy) by GM % across sales to date (STD) for Department N. The Top/Bottom screen consists of four filter prompts (merchandise level, ranking, merchandise grouping, and time). After users have made a selection for each filter, they click the Execute Report button. You cannot customize the Top/Bottom screen except for its display name and description.</td>
</tr>
<tr>
<td>Reporting</td>
<td>The Reporting screen provides access to the MicroStrategy Web Universal application and to the reports and graphs that have been supplied with Oracle Retail Price, Plan, Place, or Promote products or that you have created. You cannot customize the Reporting screen except for its display name and description.</td>
</tr>
</tbody>
</table>
The following table describes the screen layouts available with Merchant Desktop.

<table>
<thead>
<tr>
<th>Layout name</th>
<th>Representation</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout 1</td>
<td>1 4 5</td>
<td>Fixed layout</td>
</tr>
<tr>
<td></td>
<td>2 6</td>
<td></td>
</tr>
<tr>
<td>Layout 1 Inverted</td>
<td>1 2 4</td>
<td>Fixed layout</td>
</tr>
<tr>
<td></td>
<td>3 5</td>
<td></td>
</tr>
<tr>
<td>Layout 2</td>
<td>1 2</td>
<td>Fixed layout</td>
</tr>
<tr>
<td></td>
<td>3 4</td>
<td>Note: Cell 1 is 16% high, Cell 2 is 17% high, and Cells 3 and 4 are 33% high.</td>
</tr>
<tr>
<td>Layout 2 Inverted</td>
<td>1 2</td>
<td>Fixed layout</td>
</tr>
<tr>
<td></td>
<td>3 4</td>
<td>Note: Cell 2 is 16% high, Cell 3 is 17% high, and Cells 4 and 5 are 33% high.</td>
</tr>
<tr>
<td>Layout 3</td>
<td>1 2 3</td>
<td>Fixed layout</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>Layout 3 Inverted</td>
<td>1</td>
<td>Fixed layout</td>
</tr>
<tr>
<td></td>
<td>2 3 4</td>
<td></td>
</tr>
<tr>
<td>Layout 4</td>
<td>1 5</td>
<td>Fixed layout</td>
</tr>
<tr>
<td></td>
<td>2 3</td>
<td></td>
</tr>
<tr>
<td>Layout 4 Inverted</td>
<td>1 4</td>
<td>Fixed layout</td>
</tr>
<tr>
<td></td>
<td>2 3 6</td>
<td></td>
</tr>
</tbody>
</table>
### Table 4–6 (Cont.) Select Layout

<table>
<thead>
<tr>
<th>Layout name</th>
<th>Representation</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout 5</td>
<td><img src="image1" alt="Layout 5 Representation" /></td>
<td>Fixed layout</td>
</tr>
<tr>
<td>Layout 5 Inverted</td>
<td><img src="image2" alt="Layout 5 Inverted Representation" /></td>
<td>Fixed layout</td>
</tr>
<tr>
<td>Layout 6</td>
<td><img src="image3" alt="Layout 6 Representation" /></td>
<td>Fixed layout</td>
</tr>
<tr>
<td>Layout 7</td>
<td><img src="image4" alt="Layout 7 Representation" /></td>
<td>Fixed layout</td>
</tr>
<tr>
<td>Layout 7 Inverted</td>
<td><img src="image5" alt="Layout 7 Inverted Representation" /></td>
<td>Fixed layout</td>
</tr>
<tr>
<td>Layout 8</td>
<td><img src="image6" alt="Layout 8 Representation" /></td>
<td>Fixed layout</td>
</tr>
<tr>
<td>Layout 8 Inverted</td>
<td><img src="image7" alt="Layout 8 Inverted Representation" /></td>
<td>Fixed layout</td>
</tr>
<tr>
<td>Layout 9</td>
<td><img src="image8" alt="Layout 9 Representation" /></td>
<td>Fixed layout</td>
</tr>
<tr>
<td>One Column</td>
<td><img src="image9" alt="One Column Representation" /></td>
<td>Open layout</td>
</tr>
<tr>
<td>Two Column</td>
<td><img src="image10" alt="Two Column Representation" /></td>
<td>Open layout</td>
</tr>
<tr>
<td>Three Column</td>
<td><img src="image11" alt="Three Column Representation" /></td>
<td>Open layout</td>
</tr>
</tbody>
</table>

You can add as many rows as necessary, limited only by the memory available on your computer.
Copying a Screen
To create a new screen by copying the settings from an existing screen:

1. On the **Screen Administration** screen, click the **Copy** link for the screen you want.
   The **Copy Screen** screen appears.
2. On the **Copy Screen** screen, type a new screen ID in the **ID** field.
3. In the **Screen IDs Already In Use By You** field, select the screen you want.
4. Click **Save**.

Editing a Screen
Use the Edit Screen screen to modify the settings for the existing screens. The only aspect of a screen that you cannot change is the layout.

To edit a screen:

1. On the **Screen Administration** screen, under the **ID** column, click the screen you want.
   The **Edit Screen** screen appears.
2. On the **Edit Screen** screen, edit the information you want. You can also add, remove, or edit the components that are assigned to the screen.
3. Click **Save**.

Deleting a Screen
To delete a screen:

1. On the **Screen Administration** screen, click the **Delete** link for the screen you want.
   The **Delete Screen** screen appears.
2. On the **Delete Screen** screen, review the users accounts that will be affected once you delete the screen, and then click **Delete**.

---

**Caution:** There is no undo function. If you delete a screen and later want to use it, you must recreate it. In addition, deleting a screen removes it from the entire Merchant Desktop system. This means that the screen is deleted from all administrators as well as users.

Adding Components to a Screen
Screens are the containers for the components. Each screen consists of a layout and a type that determine how many components and what type of components you can add to the screen.

To add the components to a screen:

1. On the **Screen Administration** screen, under the **ID** column, click the screen you want.
   The **Edit Screen** screen appears.
2. From the list of available components, click and drag a component to the screen layout.
The component ID is highlighted in green (meaning “go”) when you select it, and the target cell outline turns red (meaning “stop” or “drop”) when you can release the mouse to place the component. When you drag the component on the screen, you can do the following actions:

- You can move the components to any cell in the layout.
- You can add the same component more than one time except for the Alert component. You can add only one Alert component per screen.
- You can remove a component from the layout by clicking the X in the upper-right corner.
- You can leave a cell blank.
- You can reposition the components by clicking and dragging the component to another cell. If the cell is occupied, that component automatically moves to the next available space, or it switches places with the moved component.

Note: You can add unlimited components only to the one-column, two-column, and three-column layouts. For the other layouts, the maximum number of components is six, and you can leave a layout cell blank.

3. When the Edit Screen screen appears with the selections you want, click the Save button.

Component Administration

The Component Administration screen lists sample components supplied with Merchant Desktop (denoted by the "pl - " prefix) and those created by you and other administrators. Components created by other administrators appear only when those administrators have selected the Allow All Administrators To Access check box for one or more components.

All of the components on this list can be assigned to one or more screens.

Use the Component Administration screen as a starting place to do the following:

- "Creating a Component” on page 4-20
- "Copying a Component” on page 4-22
- "Editing a Component” on page 4-22
- "Deleting a Component” on page 4-22

Component Administration Screen Fields

The following table describes the fields on the Component Administration screen:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Component Link</td>
<td>Click this link to create a new component. The Create Component screen appears.</td>
</tr>
<tr>
<td>Allow Users To Add</td>
<td>Click this check box to make the component available to all users.</td>
</tr>
</tbody>
</table>

Managing Reports 4-19
Creating a Component

A component is a window that can be placed on Merchant Desktop screens. Depending on the type of component you create, you can add a variety of information from sources such as HTML pages, web sites, news feeds, Oracle Retail products, and reports.

To create a component:

1. On the Component Administration screen, click the Create Component link.
   
The Create Component screen appears.

2. On the Create Component screen, enter relevant information on the fields. For more information, see "Create Component Screen Fields" on page 4-21.

3. Click Save.
   
The Component Administration screen appears, and the new component appears in alphabetical order in the ID column.
Create Component Screen Fields
The following table describes the fields on the Create Component screen:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Indicates the identification number (ID) assigned to the component. Each component name in the ID column is a link to the Edit Component where you can modify all of the component settings.</td>
</tr>
<tr>
<td>Display Name</td>
<td>The text that appears on the title bar of the component.</td>
</tr>
<tr>
<td>Description</td>
<td>This column displays the description text entered for the component (on the Create Component or Edit Component screens). To change the description, click the component name and enter a new description on the Edit Component screen.</td>
</tr>
<tr>
<td>Padding Width</td>
<td>The amount of padding (spacing) around each component. In combination with the other components, the amount of spacing between components. Select one of the following options: ■ Thin – Approximately 5 pixels around each component window, resulting in approximately 10 pixels between components. ■ Medium – Approximately 10 pixels around each component window, resulting in approximately 20 pixels between components. ■ Thick – Approximately 20 pixels around each component window, resulting in approximately 40 pixels between components.</td>
</tr>
<tr>
<td>Height</td>
<td>This option applies only to component windows in the 1-, 2-, and 3-column layouts. If the component window is in a fixed layout (such a Layout 1, Layout 1 Inverted, and so on), the height of the component window is set in the screen layout and you cannot change it. You can set the height in pixels or percentage.</td>
</tr>
<tr>
<td>Title Bar</td>
<td>Use the options in this field to show or hide the title bar for the component. Select the Hide option to show only the border of the component window without the title bar or Edit, help, minimize, or maximize buttons.</td>
</tr>
<tr>
<td>Select Component Type</td>
<td>Select one of the component types you want. For more information, see &quot;Component Types&quot; on page 4-22.</td>
</tr>
<tr>
<td>Allow Personalization</td>
<td>Click this check box to make the relevant field available for personalization.</td>
</tr>
</tbody>
</table>
Copying a Component

To create a new component by copying the settings from an existing component:

1. On the **Component Administration** screen, click the **Copy** link for the screen you want.

   The **Copy Component** screen appears.

2. On the **Copy Component** screen, type a new component ID in the **ID** field.

3. In the **Component IDs Already In Use By You** field, select the screen you want.

4. Click **Save**.

Editing a Component

Use the Edit Component screen to modify the settings for the existing components.

To edit a component:

1. On the **Component Administration** screen, under the **ID** column, click the screen you want. A screen appears that includes the edit options for the component.

2. Edit the information you want. For more information on the edit options for each component, see "**Component Types**" on page 4-22.

3. Click **Save**.

Deleting a Component

To delete a component:

1. On the **Component Administration** screen, click the **Delete** link for the component you want.

   The **Delete Component** screen appears.

2. On the **Delete Component** screen, review the users accounts that will be affected once you delete the component, and then click **Delete**.

---

**Caution:** There is no undo function. If you delete a component and later want to use it, you must recreate it. In addition, deleting a component removes it from the entire Merchant Desktop system. This means that the component is deleted from all administrators as well as users.

---

Component Types

The following components are available in Merchant Desktop:

- **HTML** – Displays the HTML page or any web site within the component window
- **HTTP Links** – Displays the links to any web site or HTML page. The web site or HTML appears in a separate browser window
- **Newsfeed** – Displays the RSS (Rich Site Summary or Really Simple Syndication) feeds
- **Product Links** – Provides the links to Oracle Retail products such as Price, Plan, Place, and Promote
- **Filtered Graph** – Displays a single graph that will update dynamically based on merchandise, location, and period hierarchy selections from the Filter component
- Graph – Displays a single graph or chart. Several graphs are supplied with Merchant Desktop. For a list of the available graphs, see Graph Components

- Filtered Report – Displays a single report that will update dynamically based on merchandise, location, and period hierarchy selections from the Filter component

- Report – Displays a single report. You can select any of the reports supplied with Merchant desktop, or any reports that you create

**HTML Component**

Use the HTML component to include an HTML page or any web site within the component window.

The following table describes the edit options for the HTML component:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Enter the path and file name of an HTML page or web site that you want to display in this component. If you want to display the HTML page or web site in a separate browser window, use the HTTP links component.</td>
</tr>
</tbody>
</table>

**HTTP Links Component**

Use the HTTP Links component to include links to any Web site or HTML page. The Web site or HTML page appears in a separate Web browser window.

The following table describes the edit options for the HTTP Links component:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Description</td>
<td>Use this option to show or hide the description text that appears beneath all of the HTTP links.</td>
</tr>
<tr>
<td>Tool Tip</td>
<td>Use this option to show or hide a tool tip for the link. The tool tip is the text that appears in a yellow box when you hover (hold the mouse pointer over) the link. The default hover text is the URL you enter for link.</td>
</tr>
<tr>
<td>Show Image</td>
<td>Use this option to show or hide the image associated to the link. This is an optional image that appears to the left of the link name. When you set up a link, you can also specify the location to the image.</td>
</tr>
<tr>
<td>Allow Add/Remove Links</td>
<td>Use this option to determine whether the users can remove or add additional links to the links you supply. Users can still change the links unless you also select the Allow Personalization check boxes for each link.</td>
</tr>
</tbody>
</table>

**Link Edit Area**

Click the Add Link button to add multiple links. To remove a link, click the Cancel icon in the top-right corner of each link.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link</td>
<td>Location (URL) of the Web site or the HTML page.</td>
</tr>
<tr>
<td>Link Name</td>
<td>Name of the link.</td>
</tr>
<tr>
<td>Link Description</td>
<td>Description text for the link.</td>
</tr>
<tr>
<td>Link Image</td>
<td>Location of the associate image.</td>
</tr>
</tbody>
</table>
Newsfeed Component

Use the Newsfeed component to include the RSS feeds.

The following table describes the edit options for the Newsfeed component:

<table>
<thead>
<tr>
<th>Table 4–11 Edit Options for the Newsfeed Component</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
</tr>
<tr>
<td>Source</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Display</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Headline Summary</td>
</tr>
<tr>
<td>Speed</td>
</tr>
<tr>
<td>Links Shown</td>
</tr>
</tbody>
</table>

Product Links Component

Use the Product Links component to provide links to the other Oracle® Retail products such as Price Optimization, Plan, Place, and so on.

The following table describes the edit options for the Product Links component:

<table>
<thead>
<tr>
<th>Table 4–12 Edit Options for the Product Links Component</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
</tr>
<tr>
<td>Show Description</td>
</tr>
</tbody>
</table>
Filtered Graph Component

Use the Filtered Graph component to include a single graph that will update dynamically based on merchandise, location, and period hierarchy selections from the Filter component.

The following table describes the edit options for the Filtered Graph component:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tool Tip</td>
<td>Use this option to show or hide a tool tip for the link. The tool tip is the text that appears in a yellow box when you hover (hold the mouse pointer over) the link. The default hover text is the URL you enter for link.</td>
</tr>
<tr>
<td>Show Image</td>
<td>Use this option to show or hide the product logo. This is an optional image that appears to the left of the link name. When you set up a product link, you can also specify the location to the image.</td>
</tr>
</tbody>
</table>

**Link Edit Area**

<table>
<thead>
<tr>
<th>Link</th>
<th>Location (URL) of the product.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link Name</td>
<td>Name of the product.</td>
</tr>
<tr>
<td>Link Description</td>
<td>Description text for the product.</td>
</tr>
<tr>
<td>Link Image</td>
<td>Location of the product logo or an associated image.</td>
</tr>
<tr>
<td>Show</td>
<td>Use the Show or Hide option to determine whether the product link information appears in the component window.</td>
</tr>
</tbody>
</table>

Graph Component

Use the Graph component to include a single graph or chart. This section includes information on the graphs formats that are supplied with Merchant Desktop.

The following table describes the edit options for the Graph component:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit To Window</td>
<td>Use this option to fit (expand or shrink) the graph in the space available. Click No to display the graph in the original size.</td>
</tr>
<tr>
<td>Selected Graph</td>
<td>Use the expand (+) and collapse (-) icons in the tree structure to select the graph (of a report) for this component.</td>
</tr>
</tbody>
</table>
**Filtered Report Component**

Use the Filtered Report component to include a single report that will update dynamically based on merchandise, location, and period hierarchy selections from the Filter component.

The following table describes the edit options for the Filtered Report component:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand to Full Width</td>
<td>Use this option to fit (expand or shrink) the report in the space available. Click No to display the report in the original size.</td>
</tr>
<tr>
<td>Selected Report</td>
<td>Use the expand (+) and collapse (-) icons in the tree structure to select the report for this component.</td>
</tr>
</tbody>
</table>

**Report Component**

Use the Report component to include a single report. You can select any of the reports supplied with Merchant desktop, or any reports that you create.

The following table describes the edit options for the HTML component:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand to Full Width</td>
<td>Use this option to fit (expand or shrink) the report in the space available. Click No to display the report in the original size.</td>
</tr>
<tr>
<td>Selected Report</td>
<td>Use the expand (+) and collapse (-) icons in the tree structure to select the report for this component.</td>
</tr>
</tbody>
</table>

**Common Edit Options for All the Components**

The following table describes the edit options that are common across all the components:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Indicates the identification number (ID) assigned to the component. Each component name in the ID column is a link to the Edit Component where you can modify all of the component settings.</td>
</tr>
<tr>
<td>Display Name</td>
<td>The text that appears on the title bar of the component.</td>
</tr>
<tr>
<td>Description</td>
<td>This column displays the description text entered for the component (on the Create Component or Edit Component screens). To change the description, click the component name and enter a new description on the Edit Component screen.</td>
</tr>
</tbody>
</table>
Padding Width: The amount of padding (spacing) around each component. In combination with the other components, the amount of spacing between components.

Select one of the following options:
- Thin – Approximately 5 pixels around each component window, resulting in approximately 10 pixels between components.
- Medium – Approximately 10 pixels around each component window, resulting in approximately 20 pixels between components.
- Thick – Approximately 20 pixels around each component window, resulting in approximately 40 pixels between components.

Height: This option applies only to component windows in the 1-, 2-, and 3-column layouts. If the component window is in a fixed layout (such as Layout 1, Layout 1 Inverted, and so on), the height of the component window is set in the screen layout and you cannot change it.

You can set the height in pixels or percentage.

Title Bar: Use the options in this field to show or hide the title bar for the component.

Select the Hide option to show only the border of the component window without the title bar or Edit, help, minimize, or maximize buttons.

Allow Personalization: Click this check box to make the relevant field available for personalization.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Padding Width</td>
<td>The amount of padding (spacing) around each component. In combination with</td>
</tr>
<tr>
<td></td>
<td>the other components, the amount of spacing between components. Select</td>
</tr>
<tr>
<td></td>
<td>one of the following options:</td>
</tr>
<tr>
<td></td>
<td>■ Thin – Approximately 5 pixels around each component window, resulting in</td>
</tr>
<tr>
<td>Height</td>
<td>approximately 10 pixels between components.</td>
</tr>
<tr>
<td></td>
<td>■ Medium – Approximately 10 pixels around each component window, resulting</td>
</tr>
<tr>
<td></td>
<td>in approximately 20 pixels between components.</td>
</tr>
<tr>
<td></td>
<td>■ Thick – Approximately 20 pixels around each component window, resulting</td>
</tr>
<tr>
<td></td>
<td>in approximately 40 pixels between components.</td>
</tr>
<tr>
<td>Title Bar</td>
<td>Use the options in this field to show or hide the title bar for the</td>
</tr>
<tr>
<td></td>
<td>component. Select the Hide option to show only the border of the component</td>
</tr>
<tr>
<td></td>
<td>window without the title bar or Edit, help, minimize, or maximize buttons.</td>
</tr>
<tr>
<td>Allow Personalization</td>
<td>Click this check box to make the relevant field available for</td>
</tr>
<tr>
<td></td>
<td>personalization.</td>
</tr>
</tbody>
</table>
Working with the Reports

The Reporting tab on the Merchant Desktop User Interface enables you to view, export, or print the reports that have been set up based on your business needs. It also enables you to save or subscribe to reports.

Merchant Desktop includes the following features that help you effectively view, export, and manage the reports:

- **Shared Reports** – includes a list of pre-defined reports.
- **Create Report** – helps you create and publish the required reports.
- **History List** – includes an up-to-date summary of the status of the requests.
- **My Reports** – includes the reports that you have created or saved for future use.
- **My Subscriptions** – includes a list of reports to which you have subscribed.
- **Preferences** – helps you set up preferences such as, Grid display, Graph display, Print, Export, and PDF.

![Figure 4–7 Reporting Tab of the Merchant Desktop User Interface](image)

Generating the Reports

The Shared Reports folder contains a list of pre-defined reports that you can use to export or print assortment based information.

To generate the shared reports:

1. On the Reporting tab, click the Shared Reports link.
2. On the Shared Reports page, click the report you want.

A form appears that helps you select the parameters before generating the report.
3. Select the parameters you want to include in the report, and then click **Execute Report**.

For each report in the Shared Reports folder, the following links provide quick access to view or set up parameters before you generate the report:

- Subscriptions – Click this link to view the subscription for this report.
- Export – Click this link to view and set up the export options in the Preferences page.
- PDF – Click this link to view and set up the PDF print options.

**Creating Your Own Reports**

The Create Report feature enables you to create your own reports that include the metrics you want. You can create a report using one of the following options:

- Report Builder – enables you to create a report based on the merchandise attributes and metrics you want. See "Using the Report Builder" on page 4-29.

**Using the Report Builder**

To create a report using the Report Builder:

1. On the Create Reports page, click **Report Builder**.
   A form appears that helps you select the attributes and metrics for the report.

2. Select the parameters you want, and then click **Execute Report**.

**Using the Report Wizard**

To create the report using the Report Wizard:

1. On the Create Reports page, click **Report Wizard**.
   A form appears that helps you select the templates and filters that you want to use in the report.

2. Once you select the templates and filters, click **Execute Report**.

**Setting Up Preferences**

The user interfaces for the Merchant Desktop and reports display information based on the display, print, and export parameters that have been set up for your user account. The Preferences feature enables you to update these parameters.

To set up preferences:

1. On the **Reporting** tab, click **Preferences**.
   The Preferences page appears, with links to the groups on the left side of the page.

2. For each group, update the preferences you want, and then click **Apply**. For more information, see "Preference Categories" on page 4-29.

To revert back to the default values, click **Load Default Values**.

**Preference Categories**

The Preferences feature includes the parameters in the following categories:

- General (See "Parameters in the General Category" on page 4-30)
- Grid Display (See "Parameters in the Grid Display Category" on page 4-30)
- Graph Display (See "Parameters in the Graph Display Category" on page 4-31)
- Print (See "Parameters in the Print Category" on page 4-31)
- Export (See "Parameters in the Export Category" on page 4-32)

**Parameters in the General Category**
The following table describes the parameters in the General category:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default start page</td>
<td>Use this parameter to select a default start page.</td>
</tr>
<tr>
<td>Locale</td>
<td>Use the parameters in this section to set up the locale settings such as language, time zone, and number and date format.</td>
</tr>
<tr>
<td>Dynamic HTML</td>
<td>Use this parameter to specify the use of Dynamic HTML in the reports.</td>
</tr>
<tr>
<td>Accessibility mode</td>
<td>Use this parameter to generate reports that are compatible with the screen readers. Select the Enable screen reader compatibility check box to enable accessibility.</td>
</tr>
<tr>
<td>Drop down menus</td>
<td>Use this parameter to view the menu options (open the menu), when you click the menu. Clear the Require mouse click to open menus check box to view the menu options when you hover the mouse pointer over the menu.</td>
</tr>
<tr>
<td>Font style</td>
<td>Use this parameter to select the font and font size for the reports.</td>
</tr>
</tbody>
</table>

**Parameters in the Grid Display Category**
The following table describes the parameters in the Grid Display category:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid Style</td>
<td>Use this parameter to specify the use of the grid format in the report definition or the default grid style you set up using the other parameters on this page.</td>
</tr>
<tr>
<td>Default Grid Style</td>
<td>Use this parameter to specify the grid style for the report.</td>
</tr>
<tr>
<td>Maximum rows in grid</td>
<td>Use this parameter to limit the number of rows that appear in the grid. In case the report contains more rows, the additional rows appear in the next page.</td>
</tr>
<tr>
<td>Maximum columns in grid</td>
<td>Use this parameter to limit the number of columns that appear in the grid. In case the report contains more columns, you can view the additional columns using the right arrow icon at the right hand corner of the report.</td>
</tr>
<tr>
<td>Show attribute form names</td>
<td>Use this parameter to view the form names of the attributes in the report.</td>
</tr>
<tr>
<td>Automatic page-by</td>
<td>Use this parameter to specify that the page automatically loads with the new information, when you select an option in the Page-by drop-down list.</td>
</tr>
</tbody>
</table>
Parameters in the Graph Display Category
The following table describes the parameters in the Graph Display category:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph size</td>
<td>Use the parameters in this section to set the size of the graph.</td>
</tr>
<tr>
<td>Show graph reports by default in 'Grid and Graph' view mode</td>
<td>Select this check box to include the graph, when you choose to view the report in the ‘Grid and Graph’ mode.</td>
</tr>
</tbody>
</table>

Parameters in the Print Category
The following table describes the parameters in the Print category:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation</td>
<td>Use this parameter to select the page orientation for the reports. You can select the Portrait option, or the Landscape option.</td>
</tr>
<tr>
<td>Paper size</td>
<td>Use this parameter to specify the page size.</td>
</tr>
<tr>
<td>Header and Footer</td>
<td>Click the Edit Custom Settings link to set up the header and footer for the reports. The Header / Footer Editor appears, which helps you set up the header and footer for the report.</td>
</tr>
<tr>
<td>Scaling</td>
<td>Use this parameter to set up the page scaling options.</td>
</tr>
<tr>
<td>Margins (inches)</td>
<td>Use this parameter to set up the page margins for the report.</td>
</tr>
<tr>
<td>Maximum header size (inches)</td>
<td>Use this parameter to limit the size of the header in the report. In case the report needs more space for the content, the headers and footers are removed from the report.</td>
</tr>
<tr>
<td>Maximum footer size (inches)</td>
<td>Use this parameter to limit the size of the footer in the report. In case the report needs more space for the content, the headers and footers are removed from the report.</td>
</tr>
<tr>
<td>Disable DHTML printing</td>
<td>Select this check box to print the report without DHTML formatting.</td>
</tr>
<tr>
<td>Show popup print dialog</td>
<td>Select this check box to display the Print dialog box when you view the Printable Version of the report.</td>
</tr>
<tr>
<td>Print cover page with filter details</td>
<td>Select this check box to include a cover page with details of the filters used in the report.</td>
</tr>
<tr>
<td>Open new window when printing</td>
<td>Select this check box to open a new page to preview the report.</td>
</tr>
<tr>
<td>Print the grid and the graph on the same page</td>
<td>Select this check box to print the graph and grid on the same page.</td>
</tr>
<tr>
<td>Expand all page-by fields when printing</td>
<td>Select this check box to include all combinations of the objects (in the Page-by axis) in the report.</td>
</tr>
</tbody>
</table>
The following table describes the parameters in the Export category:

### Table 4–22 Parameters in the Export Category

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export</td>
<td>Use this parameter to set the area for the export.</td>
</tr>
<tr>
<td>Export grids to</td>
<td>Use this parameter to specify the output format.</td>
</tr>
<tr>
<td>Export graphs to</td>
<td>Use this parameter to specify the format in which you want to export the graph. You can export the graph to the HTML or Microsoft® Excel® formats.</td>
</tr>
<tr>
<td>Export documents to</td>
<td>Use this parameter to specify the format in which you want to export the document.</td>
</tr>
<tr>
<td>Open new window when exporting</td>
<td>Select this check box to open a new page with the report that you extract.</td>
</tr>
<tr>
<td>Export metric values as text (Excel only)</td>
<td>Select this check box to extract the numeric values as text.</td>
</tr>
<tr>
<td>Export headers as text (Excel only)</td>
<td>Select this check box to extract the header values as text.</td>
</tr>
<tr>
<td>Export filter details</td>
<td>Select this check box to extract the details of the filter.</td>
</tr>
<tr>
<td>Show options when exporting</td>
<td>Select this check box to view and set up the export options, each time you export the report.</td>
</tr>
</tbody>
</table>
Viewing the Reports

Once you generate the report, you can perform various tasks on the information included in the report. On the report screen, the following menus help you edit the views, the filters, and the information in the report:

- **Report** – includes options to subscribe, save, print, or export the report. See “Report Menu” on page 4-34.
- **View** – includes options to view the graph, filters, and toolbars. See "View Menu" on page 4-34.
- **Data** – includes options to sort, drill, re-prompt, or filter the information in the report. See "Data Menu" on page 4-36.
- **Format** – includes options to edit the report interface. See "Format Menu" on page 4-37.

![Figure 4–8 Report User Interface](Image)

The following icons, on the top-right corner of the screen, provide easy access to certain commonly used features:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Icon name</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="Graph icon" /></td>
<td><strong>Graph icon</strong></td>
</tr>
<tr>
<td>Click this icon to view the graph.</td>
<td></td>
</tr>
<tr>
<td><img src="Image" alt="Grid and Graph icon" /></td>
<td><strong>Grid and Graph icon</strong></td>
</tr>
<tr>
<td>Click this icon to view the grid and graph on the same page.</td>
<td></td>
</tr>
<tr>
<td><img src="Image" alt="Grid icon" /></td>
<td><strong>Grid icon</strong></td>
</tr>
<tr>
<td>Click this icon to view the grid.</td>
<td></td>
</tr>
<tr>
<td><img src="Image" alt="Print icon" /></td>
<td><strong>Print icon</strong></td>
</tr>
<tr>
<td>Click this icon to print the report.</td>
<td></td>
</tr>
<tr>
<td><img src="Image" alt="Export icon" /></td>
<td><strong>Export icon</strong></td>
</tr>
<tr>
<td>Click this icon to extract the report in a format you want.</td>
<td></td>
</tr>
<tr>
<td><img src="Image" alt="Re-prompt icon" /></td>
<td><strong>Re-prompt icon</strong></td>
</tr>
<tr>
<td>Click this icon to generate the report with a different selection criteria.</td>
<td></td>
</tr>
<tr>
<td><img src="Image" alt="Refresh icon" /></td>
<td><strong>Refresh icon</strong></td>
</tr>
<tr>
<td>Click this icon to update the report screen.</td>
<td></td>
</tr>
<tr>
<td><img src="Image" alt="Save icon" /></td>
<td><strong>Save icon</strong></td>
</tr>
<tr>
<td>Click this icon to save the report.</td>
<td></td>
</tr>
</tbody>
</table>
Report Menu
The Report menu includes options that help you subscribe, save, print, or export the report. The following table describes the options in the Report menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Click this option to create a new report. The Create Report screen appears. For more information, see &quot;Creating Your Own Reports&quot; on page 4-29.</td>
</tr>
<tr>
<td>Save As</td>
<td>Click this option to save the report. The SAVE REPORT screen appears, which enables you to save the report in the My Reports or Shared Reports folder. On the Save Report screen, you can also create subfolders within a folder.</td>
</tr>
<tr>
<td>Add to History List</td>
<td>Click this option to add the report to the history list. The History List enables you to store and view an up-to-date summary of the generated reports.</td>
</tr>
<tr>
<td>Subscribe</td>
<td>Click this option to schedule the report on a regular basis. The SUBSCRIPTIONS panel appears on the report screen.</td>
</tr>
<tr>
<td>Print</td>
<td>Click this option to set up and view a printable version of the report. The Print Options screen appears, which helps you set up the header, footer, scaling, and other page setup options for the report. To print the report: Once you set up the print options, click Show Printable Version. The report displays in an HTML format. You can now print the report in the format you want.</td>
</tr>
<tr>
<td>Export</td>
<td>Click this option to export the report in a format you want. The Export Options screen appears, which helps you choose the format and other details for the report.</td>
</tr>
<tr>
<td>Report Details</td>
<td>Click this option to view the information on the filters, templates, and parameters used for the report. It also provides information on the SQL statements used to display the information in the report.</td>
</tr>
</tbody>
</table>

View Menu
The View menu includes options that help you view graphs, filters used, toolbars, and certain user interface components. The following table describes the options in the View menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid</td>
<td>Click this option to view the grid.</td>
</tr>
<tr>
<td>Graph</td>
<td>Click this option to view the graph. You can also click the Graph icon on the top-right corner of the screen.</td>
</tr>
<tr>
<td>Grid and Graph</td>
<td>Click this option to view both the graph and the grid on the same page.</td>
</tr>
<tr>
<td>Report Filter</td>
<td>Click this option to view the filters used to generate the report. The REPORT FILTER panel that appears on the report screen lists the filters used for the report.</td>
</tr>
</tbody>
</table>
### Table 4–24  (Cont.) Options in the View Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| View Filter  | Click this option to view and add additional filters to the report. The VIEW FILTER panel appears on the report screen. To add an additional filter:  
  1. Click **Add Condition** to add additional filter conditions to filter the information included in the report.  
  2. Once you set the attribute, click **Continue**, and then specify a condition (Qualify option) or value (Select option) for the attribute.  
  3. Click the tick mark icon (to the right) to apply the filter. |
| Object Browser | Click this option to view the objects used in the report. |
| Toolbars     | Click this option to select the toolbars that you want on the report screen. |
| Pivot Buttons | Click this option to view the pivot buttons for the columns in the report. The pivot buttons help you rearrange the information in the format you want, based on each column. It includes the following buttons:  
  ■ Move to left – Click to move the column to the left.  
  ■ Move to right – Click to move the column to the right.  
  ■ Move to columns – Click to rearrange the information in the column, and display as a group of columns.  
  ■ Move to rows – Click to rearrange the information in the column, and display it in rows.  
  ■ Page by this field – Click to rearrange the information, and display a single page that includes the information that is associated with each value in the column.  
  ■ Remove from Grid – Click to remove the column from the grid. |
| Sort Buttons  | Click this option to view the sort buttons. The sort buttons appear to the right of each column header. |
| Page_by_section | Click this option to view the PAGE BY panel on the report screen. The PAGE BY panel helps you select a different grid format for the report. |
Data Menu

The Data menu includes options that help you sort, drill, filter, or refresh the information in the report. It also enables you to insert new metrics or run the report with different selection criteria. The following table describes the options in the Data menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add View Filter Condition</td>
<td>This menu option is similar to the View Filter option in the View menu. Click this option to add an additional filter to the report.</td>
</tr>
<tr>
<td>Sort</td>
<td>Click this option to sort the information in the report. The SORT panel appears on the report screen.</td>
</tr>
<tr>
<td></td>
<td>To sort the information:</td>
</tr>
<tr>
<td></td>
<td>1. On the SORT panel, select the sort condition you want.</td>
</tr>
<tr>
<td></td>
<td>2. Click Apply to review the results.</td>
</tr>
<tr>
<td></td>
<td>Or</td>
</tr>
<tr>
<td></td>
<td>Click OK to accept the result and close the SORT panel.</td>
</tr>
<tr>
<td>Drill</td>
<td>Click this option to view the information at different levels in the report. The DRILL panel appears on the report screen. It helps you drill from an attribute, to the immediate sublevels.</td>
</tr>
<tr>
<td></td>
<td>You can also drill the report in the one of the following ways:</td>
</tr>
<tr>
<td></td>
<td>■ Hyperlink drilling – Certain objects in the report have a default drilling option, and the object appears to have a hyperlink. Click the hyperlink to drill to the information at the next level.</td>
</tr>
<tr>
<td></td>
<td>■ Right-click drilling – Right-click on an object, and use the Drill menu to drill to the level you want.</td>
</tr>
<tr>
<td>Filter on Selections</td>
<td>Click this option to view the information you want, by selecting the objects in the report and applying filters. The FILTER ON SELECTIONS panel appears. Select the objects you want to view, and then click Apply or OK.</td>
</tr>
<tr>
<td>Reset Data</td>
<td>Click this option to reset the drills or additional filters applied on the report.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Click this option to update the report screen.</td>
</tr>
<tr>
<td>Re-prompt</td>
<td>Click this option to generate the report with a different selection criteria. A form appears that shows the current selections for the report, and helps you select a different criteria for the report.</td>
</tr>
<tr>
<td></td>
<td>Once you select the criteria you want, click Execute Report to generate the report.</td>
</tr>
<tr>
<td>Insert New Metric</td>
<td>Click this option to insert a new metric in the report. The RENAME/EDIT OBJECTS panel appears. You can insert an existing metric, or create a new metric (based on the metrics available for the report).</td>
</tr>
<tr>
<td></td>
<td>To create and insert a new metric:</td>
</tr>
<tr>
<td></td>
<td>1. On the RENAME/EDIT OBJECTS panel, select New metric from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>2. In the Name field, type a name for the metric.</td>
</tr>
<tr>
<td></td>
<td>3. In the Definition field, set up a metrics definition, based on the metrics available (or displayed) in the report. For example,</td>
</tr>
<tr>
<td></td>
<td>[Pack Size] * [Num Packs]</td>
</tr>
</tbody>
</table>
Format Menu

The Format menu includes options that help you edit the report screen and review the reports better. The following table describes the options in the Format menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename/Edit Objects</td>
<td>Click this option to rename or edit the metrics you inserted in the report. The RENAME/EDIT OBJECTS panel appears. You can rename or edit the metrics that you created, through your user account.</td>
</tr>
<tr>
<td>Totals</td>
<td>Use the Totals sub menu to view the subtotals or grand totals for the following calculations:</td>
</tr>
<tr>
<td></td>
<td>■ Average</td>
</tr>
<tr>
<td></td>
<td>■ Count</td>
</tr>
<tr>
<td></td>
<td>■ Maximum</td>
</tr>
<tr>
<td></td>
<td>■ Minimum</td>
</tr>
<tr>
<td></td>
<td>■ Standard Deviation</td>
</tr>
<tr>
<td></td>
<td>■ Total</td>
</tr>
<tr>
<td></td>
<td>■ Variance</td>
</tr>
</tbody>
</table>

Table 4–26  Options in the Format Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock Grid Headers</td>
<td>This menu option enables you to review big reports better by freezing (Lock) certain rows or column headers. When you scroll through the report, it is then easier to associate each object with values.</td>
</tr>
<tr>
<td>Merge Column Headers</td>
<td>Click this option to group the column headers or values that are repeated.</td>
</tr>
<tr>
<td>Merge Row Headers</td>
<td>Click this option to group the row headers or values that are repeated.</td>
</tr>
<tr>
<td>Outline</td>
<td>Click this option to view the information represented in the expandable and collapsable sections. For most of the reports, small plus sign icons appear to the left of header in the left-most column. Click this icon to expand and view the sections within the header.</td>
</tr>
<tr>
<td>Show Banding</td>
<td>Click this option to view the alternate color bands in the reports.</td>
</tr>
</tbody>
</table>
Personalizing Merchant Desktop

This section describes how you, as a user with MD_POWER_USER role (power user), can effectively personalize the Merchant Desktop based on your need. Use the information provided in this section along with the administrative tasks, mentioned in this chapter (see "Administrative Tasks" on page 4-5), to better understand the user interface components of Merchant Desktop and the associated features.

When you first access your Merchant Desktop, the system administrator creates and assigns a view and some screens for you. You may personalize those screens and create new ones depending on the access rights assigned to your user account.

To get started with personalizing the Merchant Desktop, try these topics:

- "About Personalization" on page 4-38
- "Personalizing Your View" on page 4-39
- "Personalizing Screens" on page 4-40
- "Personalizing Components" on page 4-42
- "About Views" on page 4-42
- "About Screens" on page 4-42
- "About Components" on page 4-43

About Personalization

When you first log on to the Merchant Desktop, a view with one or more screens and components appears. This view is created for you by the administrator. Depending on the privileges assigned to your user account, you may be able to personalize the following:

- Component position and type
- Screen tab names and order, along with adding new screens
- The color scheme or "skin" of the view, which affects each screen and component
- Different aspects of each component, depending on the component type, such as the title bar of each component or the padding around it.

Personalization Privileges

Pencil buttons denote personalization. When you click a pencil button, the corresponding personalization screen appears.

- If no Pencil buttons appear, you have a standard user account, and the administrator has denied all personalizing. In this case, you will find that the view, screens, and/or components are updated with a new look or new information each time the administrator makes updates.
- If the Pencil button appears, possibly in some places but not others, you have a power user account, and the administrator has allowed you to personalize only some elements.

It is possible, however, for the administrator to remove the view of one or more screens.

- If some parameters are missing when you compare a personalization screen to the help, the administrator has prohibited the missing parameters from being changed. You may change any of the available parameters.
Personalizing Your View

You must have a power user account to make any changes to your view. If no Pencil buttons are available when you log on to Merchant Desktop, you most likely have a standard user account.

Your view consists of the row of tabs shown below:

![Figure 4–9 User View](image)

As long as the administrator has given you privileges to do so, you can personalize your view as follows:

- Add one or more screens
- Remove one or more screens
- Reorder the screens
- Change the skin (color scheme)

To personalize your view:

1. At the right end of the row of screen tabs, click the Pencil button. If the Pencil button is not available, the administrator has prohibited changes to the view. Otherwise, the View Personalization screen appears.

2. Complete the View Personalization screen as follows:

   Notes:
   - If one of the parameters listed below is missing from the screen, the administrator has prohibited that parameter from being changed.
   - If the parameter appears but is grayed out and you can’t edit it, clear the Use Default check box. That will allow you to change the parameter, but it will not allow you to receive updates from the administrator for that parameter.

<p>| Table 4–27 Personalizing Your View |</p>
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a screen</td>
<td>In the Available Screens list, click the screen name and then click the Add button. The screen name moves to the Screens In View list.</td>
</tr>
<tr>
<td>Remove a screen</td>
<td>In the Screens In View list, click the screen name and then click the Remove button. The screen name is removed from the list.</td>
</tr>
<tr>
<td>Reorder the screens</td>
<td>In the Screens In View list, click a screen name and then click the Top, Up, Down, or Bottom buttons to move the screen name to its target position.</td>
</tr>
<tr>
<td>Change the skin</td>
<td>Change skins when you want to adjust the dominant color scheme of your view, screens, and components. You can select skins from those provided by the administrator. From the Skin list box, select the name of a skin. Each skin name includes the predominant color. The color scheme of the skin you selected is applied to all of the screen tabs and all of the component title bars.</td>
</tr>
</tbody>
</table>
3. When the **View Personalization** screen reflects the changes you want, click the **Save** button.

The updates are effective immediately.

### Personalizing Screens

You must have a power user account to make any changes. If no **Pencil** buttons are available when you log on to Merchant Desktop, you most likely have a standard user account.

You may personalize screens to the extent permitted by the administrator. Following is a list of the changes you may make:

- **Screen name** - The text that appears on each screen tab and the corresponding personalization screen. Rename a screen when you want different text to appear on the screen tab.
- **Screen layout** - The order and position of the components
- **Components** - The number and type of components that appear on the screen

To personalize a screen:

1. Click the tab of the screen you want to personalize.

   The screen appears, and a **Pencil** button appears next to the name of the screen, as in this example:

   ![Figure 4–10 Personalizing Your Screen](image)

2. Click the **Pencil** button.

   The **Personalization screen** appears.

3. Complete the **Screen Personalization Screen** as follows:

   Notes:
   - If one of the parameters listed below is missing from the screen, the administrator has prohibited that parameter from being changed.
   - If the parameter appears but is grayed out and you can’t edit it, clear the **Use Default** check box. That will allow you to change the parameter, but it will not allow you to receive updates from the administrator for that parameter.
4. Click the **Save** button.

The changes you made are effective immediately.

<table>
<thead>
<tr>
<th>Table 4–28</th>
<th>Personalization Screen Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To</strong></td>
<td><strong>Do this</strong></td>
</tr>
<tr>
<td>Change the screen name</td>
<td>Enter new text in the <strong>Display Name</strong> text box. The text on the screen tab as well as the title bar of the personalization screen update with this text.</td>
</tr>
<tr>
<td>Change the position of components</td>
<td>You can change the order and position of components within the confines of the assigned screen layout type. For example, if the screen is assigned a two-column layout, you cannot change that to a three-column layout. If you need a different layout, such as more columns or a different arrangements of rows and columns, request that from the administrator. Finally, if the layout is a 1-, 2-, or 3-column open layout, you can add as many components as necessary, limited only by the memory available to your browser. In the layout, click the name of the component you want to move and drag it to the target location.</td>
</tr>
<tr>
<td></td>
<td>■ When you click the name of a component, it is highlighted in green indicating that you can “go” or “drag” the component to a cell in the layout.</td>
</tr>
<tr>
<td></td>
<td>■ As you drag the component across the layout, a red outline indicates where you can “stop” or “drop” that component. A displaced component moves to the open spot left by the moved component.</td>
</tr>
<tr>
<td>Change the number of components</td>
<td>Note: You can add unlimited components only to the one-column, two-column, and three-column layouts. For the other layouts, the maximum number of components is from one to six. You can leave a layout cell blank.</td>
</tr>
<tr>
<td></td>
<td>■ To remove a component, click the X in the upper-right corner of that component’s cell.</td>
</tr>
<tr>
<td></td>
<td>■ To add a component, click it in the list box on the left and drag it to its target location. You can add multiple copies of a component to one screen.</td>
</tr>
<tr>
<td>Change the type of components</td>
<td>Note: Some screens have components added to them by default. Select the new component type from the list box and drag it to its target location.</td>
</tr>
<tr>
<td>Edit the component</td>
<td>Click the <strong>Pencil</strong> button and complete the resulting component screen. To save the change to the component, you must click Save both on the component screen and on the Screen personalization screen.</td>
</tr>
</tbody>
</table>
Personalizing Components

You must have a power user account to make any changes. If no Pencil buttons are available when you log on to Merchant Desktop, you most likely have a standard user account.

You may personalize components to the extent permitted by the Desktop administrator. In addition, the features you may personalize depend on the component type. In general, you may change the following:

- Rename the title that appears in the title bar, or simply hide it
- Adjust the spacing between components
- Change the content of a component
- Change the look or behavior of the content

To personalize a component:

1. On the component you want to personalize, click the **Pencil** button.
   
   A screen that corresponds to the component type appears. This screen is titled the same as the component.

2. Complete the screen. The parameters differ depending on the component type:
   
   - HTML Component screen
   - HTTP Links Component screen
   - News Feed Component screen
   - Graph Component screen
   - Report Component screen

3. When the screen reflects your choices, click **Save**. The changes take effect immediately.

About Views

A view is the collection of screens and their components that appear on each user's Merchant Desktop. The administrator creates the views, screens, and components in any order, but it is helpful if you understand how they relate to each other:

- Components are the building blocks of screens, and they contain the actual content. They appear as individual windows on each screen.
- Screens are the building blocks of views, and they serve as containers for components.
- Views are the "packages" that hold the screens (basically, a row of screen tabs). Views are what an administrator assigns to Merchant Desktop users.

About Screens

Screens are the containers for components (each within its own window). Essentially, screens provide layout while component windows provide content. On the Merchant Desktop, screens are identified by the row of tabs that appear near the top of the screen. Each screen consists of the following:

- A type (Standard or Reporting)
- A layout (such as one column, two column, etc.)
One or more components

Screen Types

<table>
<thead>
<tr>
<th>Screen type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>The Standard screen is the most flexible of all the screen types, and it allows you to add all of the component types.</td>
</tr>
<tr>
<td>Reporting</td>
<td>The Reporting screen provides access to reports and graphs that have been supplied with Merchant Desktop.</td>
</tr>
</tbody>
</table>

About Components

Components are boxes of content that are placed in a screen. Components are similar to the windows you are familiar with in the Windows operating system—you may resize them, minimize them, maximize them, change their position, and close them.

Each component belongs to a parent (or owner) screen. Thus, you may access and view that component only from that parent screen. Because of this ownership, the administrator may or may not allow you to customize each component.

The same component may appear multiple times on one screen, and it may appear on multiple screens.

On the Merchant Desktop, components are identified by borders and controls such as a pencil button and an X in the upper-right corner. Component windows consist of the following:

- Properties that are common to all components, such as:
  - A type, which determines the content and properties you can set
  - A title bar description
  - A size and position in its parent (owner) screen
  - A skin (color scheme) inherited from its parent (owner) screen
- Properties that are unique to each component, such as scrolling patterns for the news feed component or specific URLs for the HTTP links component

Component Types

Each component type determines the content you may add as well as the properties you may set. Merchant Desktop provides the following component types:

- "News Feed Component Type" on page 4-43
- "HTTP Links Component Type" on page 4-44
- "HTML Component Type" on page 4-45
- "Report Component Type" on page 4-45
- "Graph Component Type" on page 4-45

News Feed Component Type

The news component is designed to display retail and other news headlines as RSS (Rich Site Summary or Really Simple Syndication) feeds.
Figure 4–11  News Feed Component Type

To pause the scrolling or fading, simply place the mouse pointer on the text. When you move the pointer, the text begins scrolling or fading again.

When you click any of the listed story titles, a new browser window opens with the text of the story.

Table 4–30  Messages - News Feed Component

<table>
<thead>
<tr>
<th>If this message appears</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error parsing RSS NEWS FEED. Bad XML File.</td>
<td>Wait until the host site updates its XML file. The XML file contains the contents of the news feed.</td>
</tr>
<tr>
<td>Error in RSS News Feed.</td>
<td>Wait until the host site updates its XML file. The XML file contains the contents of the news feed.</td>
</tr>
<tr>
<td>Too much data to download.</td>
<td>Decrease the number of links displayed and/or hide the summaries/first sentences. (Click the pencil button and complete the resulting News Component Feed screen). This message appears when the XML contains greater than 10,000 characters for display.</td>
</tr>
</tbody>
</table>

To change the appearance or contents of this News Feed component, click the Pencil button in the title bar and you will see the News Feed Component screen. If the pencil button is not present in the title bar, the administrator has prohibited this component from being changed.

HTTP Links Component Type

The HTTP Links component displays links to any web site. For example, you may want to display links to competitors’ web sites, or you may want to display links to sites that you access often throughout the day.

Figure 4–12  HTTP Links Component Type

When you click a link, a new browser window opens. To return to Merchant Desktop, do any of the following:

- Close the browser window that just opened.
- Press Alt+Tab until the Internet Explorer Merchant Desktop icon is selected.

To change the appearance or contents of this HTTP Links component, click the Pencil button in the title bar and you will see the HTTP Components screen. If the Pencil
button is not present in the title bar, the administrator has prohibited this component from being changed.

**HTML Component Type**
The HTML component displays information that originates in HTML format. It is intended for displaying corporate calendars, promotional event dates, company intranet Web site, and so on.

*Figure 4–13 HTML Component Type*

To change the appearance or contents of this HTML component, click the Pencil button in the title bar and you will see the HTML Component screen. If the Pencil button is not present in the title bar, the administrator has prohibited this component from being changed.

**Report Component Type**
The Report component provides you with a single report specific to your company's data.

*Figure 4–14 Report Component Type*

While the Reporting screen (see "Screen Types" on page 4-43) provides access to all graphs and reports, you may want to set up a component for a specific report for which you have created custom filters. For that case, Merchant Desktop provides you with this Report component (as well as a "Graph Component Type" on page 4-45).

To change the appearance or contents of this Report component, click the Pencil button in the title bar and you will see the Reports Component screen. If the Pencil button is not present in the title bar, the administrator has prohibited this component from being changed.

**Graph Component Type**
The Graph component provides you with various graphical visual aids you may personalize to your company's data.

*Figure 4–15 Graph Component Type*
While the Reporting screen (see "Screen Types" on page 4-43) provides access to all graphs and reports, you may want to set up a component for a specific graph that you have customized. For that case, Merchant Desktop provides you with this Graph component (as well as a "Report Component Type" on page 4-45).

**Pie Charts**
MicroStrategy comes with the ability to create Pie charts and display them through the Merchant Desktop.

*Figure 4–16  Pie Charts*

![Pie Chart]

**Bar and Line Charts**
MicroStrategy comes with the ability to create line and Bar Charts that may be displayed through the Merchant Desktop.

*Figure 4–17  Bar and Line Charts*

![Bar and Line Chart]

To change the appearance or contents of this Graph component, click the pencil button in the title bar and you will see the Graph Component screen. If the pencil button is not present in the title bar, the administrator has prohibited this component from being changed.

**Other**
MicroStrategy comes with various types of Graphs you may access through the Merchant Desktop. To explore your options, go to the Reports Tab and click on the Preferences option and the Graph display hyperlink. Follow the Micro Strategy Help.

**Troubleshooting**
Following are problems and solutions for the Merchant Desktop feature:
<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>I can’t change anything, and there are no pencil buttons.</td>
<td>This occurs when your user account is assigned a read-only role that prohibits any changes. If you want to be able to customize some Merchant Desktop features, ask the administrator to update your user account.</td>
</tr>
<tr>
<td>The help lists some options that don’t appear on my screens.</td>
<td>The help system shows all of the available Merchant Desktop options, but your user account may be prohibited from using those options. When this is the case, the option does not appear in the user interface. For example, if your user account prohibits adding web sites to the HTTP links component, the Add button does not appear on the HTTP links personalization screen.</td>
</tr>
<tr>
<td>There are some changes on my Merchant Desktop view, screen, or component that I didn’t make.</td>
<td>When this occurs, most likely Merchant Desktop is configured so that you automatically receive updates from the administrator. To avoid this, clear the Use Default check box (the “default” is any change the administrator makes). You must do this for each parameter that you do not want to be updated. If later you do want the administrator updates, select the Use Default check box. If the Use Default check box does not appear on your screens, the administrator has turned that option off.</td>
</tr>
<tr>
<td>The administrator made some changes to the view, screens, or components, but I didn’t receive the changes.</td>
<td>Check the settings for the Use Default check boxes. For each parameter, you can receive updates from the administrator only if the check boxes is selected. If the check boxes are selected, try quitting all of the open browser windows and then logging in to Merchant Desktop again.</td>
</tr>
<tr>
<td>I hid the title bar on a component. How do I get it back?</td>
<td>If the pencil button is not available, you must ask an administrator to do this for you. To show a hidden title bar:</td>
</tr>
<tr>
<td></td>
<td>1. For the screen that contains the component with the hidden title bar, click the screen tab and corresponding pencil button.</td>
</tr>
<tr>
<td></td>
<td>2. On the Screen Personalization screen in the graphic of the screen layout, click the pencil button of the component whose title bar you want to show.</td>
</tr>
<tr>
<td></td>
<td>3. On the component personalization screen, select the Show option and click the Save button.</td>
</tr>
<tr>
<td></td>
<td>4. On the Screen Personalization screen, make any other changes necessary and then click the Save button. The screen appears, and the title bar is back on the component window.</td>
</tr>
<tr>
<td>I can’t scroll to all of the prompts on the Top/Bottom screen</td>
<td>If you have a scroll wheel on your mouse, use that to scroll down on the screen. Otherwise, use the horizontal scroll bar to scroll to the right until the MicroStrategy vertical scroll bar appears.</td>
</tr>
<tr>
<td>Only one of my fading news feeds shows news, but the other one is blank</td>
<td>Replace one of the fading news feed components with a different news feed display, such as static. Currently, you can have only one fading news feed per screen.</td>
</tr>
<tr>
<td>I clicked a tab and the screen components are taking a long time to load, but when I click a different tab to go to another screen, that screen won’t appear</td>
<td>This situation can occur when the screen you are accessing has multiple MicroStrategy reports and/or graphs. Sometimes you must wait until the reports or graphs have loaded before you can navigate to another screen.</td>
</tr>
</tbody>
</table>
### Table 4–31 (Cont.) Troubleshooting for Merchant Desktop

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>My password is no longer working</td>
<td>Passwords are case-sensitive, so make sure that the Caps Lock is off. In addition, if the administrator has changed your password or user name recently, it's possible that Internet Explorer is using the wrong stored password. This can occur when the only change in the user name or password is case.</td>
</tr>
<tr>
<td>Everything was working fine, but then I clicked a link and this message appeared: This page cannot be displayed</td>
<td>When this message appears, quit the browser and then start it again and access Merchant Desktop. If that does not solve the problem, the server may be down. Inform the administrator.</td>
</tr>
</tbody>
</table>
| A MicroStrategy log on screen appears instead of the reporting screen, and when I attempt to use the log on screen, nothing happens. | This can occur in the following circumstances:  
- The MicroStrategy Intelligence Server and Web Universal application are not available.  
- The password you are using is invalid, or your user name and password are not in the MicroStrategy users database.  
In both of these cases, notify the administrator. |
| The following Job Expired message appears when I attempt to access a report or graph: The results for this report are no longer available. Please submit the request again. | This is a MicroStrategy error message. When it occurs, click the Re-Execute Report button. Typically the report will update when you click this button. |
| Accessing the Reporting screen or any screen that contains a report or graph takes a long time. | The slow access time should occur only the first time you access reporting. All subsequent times should be much quicker. |
| The following message appear when I am using MicroStrategy, particularly the Top/Bottom screen: The Web Server encountered an unknown runtime error. | This is a MicroStrategy error message. When it occurs, click the Top/Bottom tab in the Merchant Desktop view. This refreshes the screen, and you can then select your filters and execute your report. |
| When a graph first appears, it fits in the component window, but when I drill down or navigate to a different page, the graph becomes larger than the component window. | This is a known issue with the MicroStrategy Web Universal application. When it occurs, you must navigate to a different screen and then back to the screen that contains the graph.  
If you find this happens too frequently, ask the administrator to place the graphs in larger component windows. In some cases, you might even want one graph per screen, depending on the complexity of the graph. |
| I drilled down through a graph or report, but now I can’t drill back up. | In MicroStrategy reports and graphs, there is no way to drill back up. Instead of re-executing the graph or report, MicroStrategy recommends using the browser back button. |
| Some folders in the Selected Report or Selected Graph tree won’t close. | You cannot close the folder (or the parent folder) that contains the selected report. |
| I want to select a report or graph for one of the report or graph components, but there are no folders under the Please Select a Report folder. | This occurs when the MicroStrategy Intelligence Server and Web Universal application are not available. It can also occur when your user name is not in the MicroStrategy user database. Notify the administrator. |
| I want to change the type of layout of a screen but can’t find a way to do it in the user interface. | It is currently not possible to change the layout of a screen. Instead, you must create a new screen. |
| For components in open layouts (i.e., 1-, 2-, and 3-column), very large height parameters cause unpredictable window sizes. | Ultimately, the effects of height and width are controlled by the browser, not by Merchant Desktop. If the browser window sizing is not working as you expect, try decreasing the height of component windows. |
Good Practices

This section describes the following recommended practices:

■ “Copy the Sample Views, Screens, or Components” on page 4-49
■ “Lock Views, Screens, or Components until You Are Ready to Share Them” on page 4-49
■ “Test Your Views, Screens, or Components with Test User Accounts” on page 4-49

Copy the Sample Views, Screens, or Components

If there is more than one administrator using Merchant Desktop, copy the sample views, screens, or components instead of making changes directly to them. (All samples begin with a "pl - " prefix.) This preserves the original sample views, screens, and components for all other administrators.

For example, the samples are available to all administrators by default. Thus, if you and a few other administrators happen to edit the same screen at the same time, only the last-saved version is preserved. Therefore, it is possible for your changes to be lost. You can avoid this scenario if you copy and rename samples before making changes to them.

Lock Views, Screens, or Components until You Are Ready to Share Them

When you copy a sample or create a new view, screen, or component, make sure that the Allow All Administrators To Access check box is not selected (this is the default). As long as that check box is not selected, other administrators cannot see or change views, screens, or components that you have created. This is helpful when you are in the process of setting up views, screens, and components.

When you are finished setting up your views, screens, and components and you want to share them with other administrators, simply make a copy first and then select the Allow All Administrators To Access check box. Your original copy is then preserved but other administrators can still access the views, screens, or components that you want to share.

Test Your Views, Screens, or Components with Test User Accounts

It is recommended that you assign the sample views to a test user account rather than to your own account. As an administrator, you have special privileges that standard users and power users do not have, and this can affect the functionality of the view, its screens, and its components. When you log on with a test user account, you can see the view exactly the way that users will.

■ To create two user accounts (e.g., one standard user and one power user) for testing purposes, see "Creating a User Account” on page 1-7.
■ To assign a view to a test user account, see "Assigning a View to a User” on page 4-12.
Managing Subscriptions to DAL Capture

This chapter provides information on the Data Access Layer (DAL) capture mechanism in the Calc Engine that logs each action carried out by the Calc Engine. It also describes how you can configure it for users who request this information so that the support teams can analyze the calc engine actions.

It includes the following sections:

- About the DAL Capture Mechanism
- Subscribing User Accounts for DAL Capture

About the DAL Capture Mechanism

The Calc Engine includes a Data Access Layer (DAL) Capture feature that can be used to capture the actions carried out by the Calc Engine. The DAL mechanism captures the data gathered by the Calc Engine into a comma separated value (CSV) flat file.

This mechanism, along with the request/response XML messages, helps the support and analytics teams to analyze the results of a forecasts or allocations.

Subscribing User Accounts for DAL Capture

By default, the DAL Capture mechanism is toggled OFF in the application, to switch ON the mechanism and start recording a CE dump you must subscribe the user account for this mechanism.

You can subscribe the user accounts for the DAL Capture (on request) using the `enableCEDump.sh` (located in `<Plan_Installation/modules/bin folder`) command line utility.

To include the users for the DAL Capture:

1. On the command prompt, navigate to the following location in the Plan installation folder:

   `<Plan_Installation>/modules/bin/`

2. Run the following command:

   `bash enableCEDump.sh`

3. Follow the command line instructions to enable the DAL Capture mechanism for a particular user.
Once the mechanism is enabled for a user, the user must run the request again to record the DAL information. After the recording is complete, you can send this Calc Engine information to the support and analytics teams for analysis.

**Location of the Calc Engine Dump**

The `engine.csvdal.recordTo` parameter in the `delphi.properties` file specifies the location where the Calc Engine dump gets stored (in .csv format). If this parameter is not set, the information get stored in the Calc Engine logs directory.

The `engine.csvdal.clobber` parameter in the `delphi.properties` file specifies (value set to True) whether the existing Calc Engine dump files be deleted, before the recording begins. When set to False, the existing files in the recording directory are updated with the data from the current recording session.
Index

A
about
  components, 4-5, 4-43
dal capture, 5-1
merchant desktop, 4-1
screens, 4-5, 4-42
store sets, 3-1
subsets, 3-1
views, 4-5, 4-42
accessing
  merchant desktop, 4-2
add
  screen to view, 4-12
administration
  screen, 4-13
  view, 4-9
alert component
  limit of one per screen, 4-19
apply filters, 3-15
assign
  view to user, 4-12

B
business rule history screen, 2-11
business rule management
  browsing hierarchies, 2-6
  copy rule settings, 2-10
  expand hierarchies, 2-7
  filters panel, 2-5
  find hierarchy entity, 2-8
  grid panel, 2-5
  modify rule settings, 2-9
  remove rule settings, 2-10
  user interface, 2-4
  view rule modification history, 2-11
business rule settings
  copy, 2-10
  modify, 2-9
  remove, 2-10
business rules
  about, 2-1

C
color schemes (see skins)
common edit options, 4-26
component
  common edit options, 4-26
  filtered graph, 4-25
  filtered report, 4-26
  graph, 4-25
  HTML, 4-23
  HTTP links, 4-23
  newsfeed, 4-24
  product links, 4-24
  report, 4-26
component administration, 4-19
  copy component, 4-22
  create component, 4-20
  delete component, 4-22
  edit component, 4-22
component administration screen, 4-19
component types, 4-22
components
  composed of, 4-43
  customizing, 4-42
  defined, 4-43
  HTTP links, 4-44
  links to web sites, 4-44
  list of types, 4-43
  news feed, 4-44
  placement related to screen layout, 4-41
  renaming, 4-42
  repositioning, 4-41
  RSS feeds, 4-44
create
  reports, 4-29
creating
  views (administrators), 4-10
customizing components
  general procedure, 4-42

D
dal capture
  about, 5-1
  subscribe, 5-1
data menu, 4-36
drag and drop component positions, 4-41

E
error in RSS news feed, 4-44
Errors
   This page cannot be displayed, 4-48
   unknown runtime error, 4-48
errors
   error parsing RSS news feed, 4-44
   RSS news feed, 4-44
too much data to download, 4-44
excel
   exporting user account information, 1-14
export to pdf (microstrategy administrators), 4-2
exporting user account information, 1-14

F
filtered graph component, 4-25
filtered report component, 4-26
filters
   apply, 3-15
force reset password, 1-12
format menu
   menu
      format, 4-37

G
generate
   reports, 4-28
graph component, 4-25

H
history list (microStrategy administrators), 4-2
HTML component, 4-23
HTTP Links component, 4-44
HTTP links component, 4-23

L
layouts
   changing, 4-16
   list, 4-16
library grid, 3-2
location hierarchy
   changing levels of access, 1-10

M
manage
   store sets, 3-3
manage subsets, 3-9
menu
   data, 4-36
   report, 4-34
merchandise hierarchy
   changing levels of access, 1-10
merchant desktop, 4-1
   access, 4-2
good practices, 4-49
   personalize, 4-38
post-install configuration, 4-2
reporting tab, 4-28
roles, 1-4
troubleshooting, 4-46
user account microstrategy, related to, 1-5
microstrategy
   export to pdf (administrators), 4-2
   history list (administrators), 4-2
MicroStrategy screen
can’t log on, 4-48
move stores, 3-18

N
news component, 4-44
newsfeed component, 4-24

P
parsing RSS news feed, 4-44
passwords
   case-sensitive, 1-6
   changing for root user account, 1-6
personalize
   about, 4-38
   add screen, 4-39
   change skin, 4-39
   component, 4-42
   remove screen, 4-39
   reorder screen, 4-39
   screen, 4-40
   view, 4-39
preferences
   export, 4-32
   general, 4-30
   graph display, 4-31
   grid display, 4-30
   print, 4-31
printing
   user account information, 1-14
privileges
   personalization, 4-38
product links component, 4-24

R
renaming
   components, 4-42
   renaming screens, 4-41
   renaming tabs, 4-41
   renaming subsets, 3-15, 3-16
   report builder, 4-29
   report component, 4-26
   report menu, 4-34
   report wizard, 4-29
Reporting
   access time is very slow, 4-48
MicroStrategy log on screen appears, 4-48
reporting screen type, 4-15, 4-43
reports
create, 4-29
generate, 4-28
preferences, 4-29
view, 4-33
Reports take a long time to appear, 4-48
repositioning components, 4-41
roles, 1-3
about, 1-2
merchant desktop, 1-4
plan, 1-3
user management, 1-3
RSS feeds
component, 4-44
S
screen
screen administration, 4-13
screen administration, 4-13
add components to screen, 4-18
create screen, 4-14
delete screen, 4-18
Screen Administration screen, 4-13
screen layouts, 4-15
screen types, 4-14
screens
component administration, 4-19
layouts and component placement, 4-41
renaming, 4-41
reporting type, 4-15, 4-43
setting home screen, 4-40
top/bottom type, 4-15
view administration, 4-9
setting home screen, 4-40
skin
change, 4-39
skins
changing on view, 4-39
spreadsheet
exporting user account information, 1-14
store set information
customize columns, 3-8
export, 3-7
print, 3-7
sort, 3-7
store sets
about, 3-1
add other store sets, 3-6
copy selected, 3-3
create, 3-3
library grid, 3-2
manage, 3-3
merge, 3-4
remove, 3-5
rename, 3-4
view other stores, 3-6
store sets library grid, 3-2
store sets management
accessing, 3-2
stores
find, 3-18
move, 3-18
rearrange, 3-16
subscribe
dal capture, 5-1
subsets
about, 3-1
add stores, 3-13
change to static type, 3-13
combine, 3-11
create, 3-11
manage, 3-9
remove, 3-12
rename, 3-11
reorder, 3-16
subsets information
customize columns, 3-13, 3-19
export, 3-13, 3-19
print, 3-13, 3-19
T
tabs
renaming, 4-41
This page cannot be displayed, error, 4-48
To, 4-12, 4-14, 4-18
top/bottom screen type, 4-15
U
unassigned view, 4-6
unassigned view message
customizing, 4-6
updates, 4-8
user account roles, 1-3
user accounts
changing assigned hierarchy levels, 1-10
changing user name and password, 1-9
creating, 1-7
determining product access, 1-8
expire password, 1-12
inactivating, 1-11
locking, 1-11
microstrategy, related to, 1-5
modifying, 1-9, 1-10
roles, assigning, 1-8
roles, changing, 1-10
unlocking, 1-11
user management
assigning roles to user accounts, 1-8
changing password for root user account, 1-6
creating user accounts, 1-7
default user account, 1-6
deleting user accounts, 1-11
expire user account, 1-12
exporting, 1-14
hiding columns, 1-13
inactivating user accounts, 1-11
locking user accounts, 1-11
logging on for the first time, 1-6
modifying user accounts, 1-9, 1-10
printing, 1-14
rearranging columns, 1-13
removing user accounts, 1-11
roles, 1-3
root user name, 1-6
sorting information, 1-12
starting, 1-6
unlocking user accounts, 1-11
users
  receiving unassigned view message, 4-5

V

view
  add screen, 4-12
  assign to user, 4-12
  changing skins, 4-39
  history of rule modifications, 2-11
  reports, 4-33
view administration, 4-9
  add screen to view, 4-12
  assign view to user, 4-12
  copy view, 4-11
  create view, 4-10
  delete view, 4-11
  edit view, 4-11
view menu
  menu
    view, 4-34
views
  creating (administrators), 4-10
  customizing unassigned view message, 4-6
  setting home screen, 4-40

W

Web Server
  unknown runtime error, error, 4-48
web sites
  component, 4-44